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Document Disclaimer
The information in this document has been carefully checked and is believed to be 
reliable. However, no responsibility can be assumed for inaccuracies that may not have 
been detected. LeCroy reserves the right to revise the information in this document 
without notice or penalty.

Changes or Modifications
Any change or modification not expressly approved by LeCroy voids the user’s authority 
to operate this equipment.

Trademarks and Servicemarks
CATC, LeCroy Voyager, USB Protocol Suite, USB Advisor, USB Chief, USB Inspector, 
USB Detective, USB Tracer/Trainer, and BusEngine are trademarks of LeCroy. 

Microsoft and Windows are registered trademarks and Windows Vista is a trademark of 
Microsoft Inc.

Intel is a registered trademark, and Core is a trademark, of Intel Corporation.

All other trademarks are property of their respective companies.

Copyright
Copyright © 2008, LeCroy Corporation. All Rights Reserved. This document may be 
printed and reproduced without additional permission, but all copies should contain this 
copyright notice.

FCC Conformance Statement
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user is required 
to correct the interference at his own expense. The end user of this product should be 
aware that any changes or modifications made to this equipment without the approval of 
LeCroy could result in the product not meeting the Class A limits, in which case the FCC 
could void the user's authority to operate the equipment.

EU Conformance Statement
This equipment complies with the EMC Directive 89/336/EEC and the Low Voltage 
Directive 73/23/EEC, and their associated amendments for Class A Information 
Technology Equipment. It has been tested and found to comply with EN55022:1998 
Class A (EN61000-3-2:1998, EN61000-3-3:1995) and EN55024:1998 
(EN61000-4-2:1998, EN61000-4-3:1996, EN61000-4-4:1996, EN61000-4-5:1996, 
EN61000-4-6:1997, EN61000-4-11:1998), and EN60950:1999. In a domestic 
environment this product may cause radio interference in which case the user may be 
required to take adequate measures.
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WEEE Program

 

This electronic product is subject to  
disposal and recycling regulations that  
vary by country and region. Many  
countries prohibit the disposal of  
waste electronic equipment in  
standard waste receptacles. 
For more information about proper  
disposal and recycling of your LeCroy  
product, please visit  
www.lecroy.com/recycle. 
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Chapter 1:  Overview
The LeCroy Voyager M3™ Analyzer and Exerciser system is a multifunction verification 
system for USB 2.0 and USB 3.0 development and testing. It is designed to record traffic 
and graphically present the logical USB transactions and events. It can also generate 
USB traffic. The system is connected to a laptop or desktop via its USB or Gigabit 
Ethernet port. 

Figure 1.1 Voyager M3 Analyzer Exerciser System

The recommended system requirements are:

Recommended Host PC Configuration

• Intel® Core™ 2 Duo
• USB 2.0 interface
• 1 GB RAM

Supported Operating Systems

• Microsoft® Windows® XP, Windows Vista™ 32, or Windows Vista 64

Please see the Readme file on the installation CD for the latest information on PC requirements 
and supported operating systems.
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USB 2.0 and USB 3.0 Features
The system can monitor traffic between USB 2.0 links using standard high-speed 
compliant cables. 

If configured for USB 3.0 testing, the system supports monitoring between SuperSpeed 
links using USB 3.0 cables (Figure 1.2)

Figure 1.2 Direct Connection using USB 3.0 Cables

or through direct connection via MMCx-to-SMA coaxial cables (Figure 1.3).

Figure 1.3 Direct Connection using SMA Differential Tap
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Models
The models available are:

Note: ($) means additional cost.

Model

Voyager M3 
Advanced
USB 2.0 
Analyzer
USB-T0A2-V01-X

Voyager M3 
Advanced
USB 2.0 
Analyzer with
Exerciser
USB-TZA2-V01-X

Voyager M3
Pro
USB 3.0 
Analyzer
USB-T0P3-V01-X

Voyager M3
Pro
USB 3.0
Analyzer with
Exerciser
USB-TZP3-V01-X

USB 2.0 / USB 1.1 Recording x x x x

USB 2.0 OTG Recording x x x x

USB 3.0 / SuperSpeed  
Recording

x x

USB 2.0 Traffic Generation x

USB 3.0 Traffic Generation x

Standard Recording Memory 1 GB 1 GB 4 GB 4 GB

Slow-clock and 
External Clock Option

x ($) x ($) x ($) x ($)

SMA Differential Tap Option x ($) x ($)
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1.1 General Description
The Analyzer is configured and controlled by a portable or desktop PC connected via its 
USB port. The familiar “CATC Trace™” user interface is an industry standard for 
documenting the performance of high-speed serial protocols. 

The testing tool for the USB protocol provides traffic capture and analysis. Hardware 
triggering allows capture of real-time events. Hardware filtering allows filtering different 
packet types in or out of the recording. Filtering allows you to focus recordings on events 
of interest and to preserve recording memory, for extended recording time.

Recorded data displays in colored graphics in a trace viewer application. This application 
has advanced search and viewing capabilities that allow you to quickly locate specific 
data, errors, and other conditions, thereby focusing attention on events of interest. 

The system functions with any personal computer having the Microsoft® Windows® XP, 
Windows Vista™ 32, or Windows Vista 64 operating system and a functional USB 
interface or Ethernet port. 

The system provides on-the-fly detection of, and triggering on, such events as Tokens 
and Errors. Whether recording manually or with a specified trigger condition, the system 
continuously records the link data, in a wrap-around fashion, until manually stopped or 
until the Trigger Event is detected and a specified post-Trigger amount of link data is 
recorded.

Upon detection of a triggering event, the Analyzer continues to record data up to a point 
specified by you. Real-time detection of events can be individually enabled or disabled to 
allow triggering on events as they happen. This includes predefined exception or error 
conditions and a user-defined set of trigger events. The unit can also be triggered by an 
externally supplied signal.

The software provides powerful search functions that enable investigation of particular 
events. In addition to immediate analysis, you can print any part of the data. Use the 
Save As feature to save the data on disk for later viewing. The program also provides a 
variety of timing information and data analysis reports.

Please refer to the Universal Serial Bus Specification for details on the protocol. The USB 
specification is available from the USB Implementers Forum (USB-IF) at: 

USB Implementers Forum 
1730 SW Skyline Blvd.  
Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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1.2 Features
General
• Fully compliant with USB specification revisions.
• Supports the Link Power Management Extension.
• Flexible design with reconfigurable hardware for future enhancements.
• Convenient modular system architecture with field upgradeable firmware and 

recording engine.
• Supports all USB speeds (5 Gb/s, 480 Mb/s, 12 Mb/s, and 1.5 Mb/s).
• User friendly CATC Trace interface displays bus traffic using color and graphics.
• Trace Viewer available as free non-recording, view-only software.
• Online manual
• Power-on self-diagnostics
• 13 Month warranty and hot-line customer support
• Software upgradable Exerciser function
• Remote control of USB analyzers in a network

Physical Components
• Operated by any desktop or portable Microsoft Windows XP, Windows Vista 32, or 

Windows Vista 64 computer with USB or Ethernet capability. 
• Convenient Plug-and-Play USB installation
• High impedance tap inserts non-intrusively in any branch of a USB system
• 1 GB or 4 GB of physical data recording memory
• USB 2.0 Hi-Speed USB connection to desktop or portable host PC
• Internal wide-range AC power supply
• Expansion port for future enhancements
• SMA connectors and USB 3.0 connectors for SuperSpeed capture and generation
• External clock inputs and outputs
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Recording Options
• Versatile triggering: bit-wise value and mask data patterns up to sixteen bytes wide 

for Setup transactions and data packets (2.0)
• Triggering on new High-speed PIDs and split transaction special tokens (ERR, 

SPLIT, PING, NYET, DATA2, and MDATA) (2.0)
• CATC Trace displays and enumerates High-speed Micro Frames (2.0)
• Three forms of triggering: Snapshot, Manual and Event
• Transaction sequencer allows triggering on a token qualified by a data pattern and 

specific handshake or alternately transactions can be filtered (for example, NAK’d 
transactions). (2.0)

• Advanced triggering with event counting and sequencing (2.0)
• Dedicated trigger for recording input and output used to interface to external test 

equipment
• Triggering on multiple error conditions: PID bad, bit stuffing bad, CRC bad, 

end-of-packet bad, babble, loss of activity, frame length violation, time-out or 
turn-around violation, data toggle violation, Token, Bus Conditions, Data Length, 
excessive empty frames (2.0)

• Real-time traffic capture filtering and data packet truncation variable up to 256 bytes 
(2.0)

• Adjustable buffer size from 0.4 MB to 1 GB or 4 GB
• Idle filtering (3.0)
• Simultaneous 2.0 and 3.0 capture
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Display Options
• Utilizes the CATC Trace graphical display of bus packets, transactions, split 

transactions and transfers.
• Numerous packets and transactions can be grouped under a single transfer while 

quickly decoding all essential information.
• Decoding of split transactions up and down stream of a transaction translator is 

accomplished with a special hierarchical view.
• Variety of reports summarizes key statistics and conditions of interest, with the abil-

ity to jump to the selected item in the trace display.
• Trace Viewer is backward compatible with USB Advisor™, USB Chief™, 

USB Inspector™, and USB Detective™ trace files. They are converted upon 
loading

• User-friendly trigger position indicated by different colors of pre- and post-trigger 
packet color.

• Markers can be set to assist with navigation and time calculations. 
• Hide start-of-frame (SOF) packets, as well as any packet or transaction from a 

device address and endpoint
• Search for a specific PID.
• Detects and alerts you to every potential bus error, protocol violation, and 

combinations thereof.
• High resolution, accurate time stamping of bus packets, timing measurement and 

analysis functions
• Extensive search and packet hiding capabilities
• Comprehensive device class decoding, plus user-defined protocol decoding
• Data View (2.0 and 3.0)
• Link Tracker to view symbols of traffic (3.0)
• Spec View to show packets in the same format as the USB 3.0 specification (3.0)
• Quick Timing Markers to immediately show time deltas and bandwidth use

Traffic Generation
• Traffic generation capability (2.0)

Hi-Speed Slow Clock
• Trace and Generate Hi-Speed traffic at fractional (slow) clock rate capability (2.0)
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1.3 Graphical Bus Traffic Display
The transaction displays use color and graphics to show the captured transactions in an 
immediate, understandable and useful format.

Packets are shown on separate rows, with their individual fields both labeled and 
color-coded. Packets are also numbered (sequentially, as recorded) and time-stamped. 
Protocol errors are automatically detected and visibly highlighted in red.

The display is customizable, allowing you to control the color scheme and the formatting 
of field contents. A hide feature allows you to enable the suppression of SOF packets and 
user-defined packets or fields that might be uninteresting in a given context. Display 
formats can be named and saved for later use. Pop-up tooltips annotate packet fields with 
more detailed information about their contents. 

The display software operates independently of the hardware, allowing it to function as a 
stand-alone "trace viewer" that is freely distributed. 

1.4 Accurate Time Management
The internal counter/timer circuitry enables a reliable, accurate (2 ns resolution) time 
stamping of recorded bus traffic. This timing information is displayed in the trace and in 
measurement and analysis functions. You can add any number of markers to denote 
specific packets, and further timing measurements can be made from one marker to 
another or from marker to trigger. All time fields are presented as a time stamp, idle time, 
bit time, or in a new time delta in either decimal or hexadecimal format.

An essential feature of time management is that idle traffic does not consume the 
Analyzer memory. Because of this unique technology, accurate timing calculations can 
be made while still preserving valuable recording memory for important bus traffic.

The highly accurate oscillator has 2.5 ppm accuracy.
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1.5 Comprehensive Error Detection and Analysis
The system detects and alerts you to every potential bus error, protocol violation, and 
combinations thereof. The Analyzer contains circuitry in the BusEngine™ to perform 
real-time triggering on multiple error conditions, such as PID bad, bit stuffing bad, header 
or data CRC bad, end-of-packet bad, babble, loss of activity, frame length violation, 
time-out or turn-around violation and data toggle violation. The Analyzer program 
highlights all hardware-detected errors and further examines the trace file for additional 
protocol errors, including wrong packet length, data payload violation, and packet 
termination not on a byte boundary.

1.6 Real-Time Event Triggering and Capture Filtering 
(2.0)

No attribute of a bus and protocol Analyzer is more important than its capacity for 
extracting useful information from a crowded stream of bus traffic. The ability to 
accurately identify and selectively record transactions of interest is a valuable trait. The 
system uses a set of “recording resources,” more than a dozen configurable hardware 
building blocks that can be optimized to perform a particular activity appropriate to the 
task. A recording resource can independently await an initialization signal, monitor its 
external environment (external signals or other resources) in search of a particular event, 
and take a subsequent action (triggering, inclusive or exclusive filtering, and counting). 
Under control of the user interface, these resources can be selected, configured, and 
combined to search for complex trigger conditions and selectively capture the associated 
transactions.

Thus, as well as triggering on basic events, such as specific bus conditions, packet 
identifiers (PID), and so on (see the Specifications section for a complete list), the system 
can easily manage the most challenging requirements. For example: “trigger on the fifth 
occurrence of a SETUP Token device number nine”, or “trigger on a SET INTERFACE 
request, following a specified eight-byte bulk data pattern match from this scanner, and 
do not capture any start-of-frame (SOF) packets.”

You can set the size of the recording memory, specify the pre- and post-trigger capture 
ratio, and truncate large data packets up to 256 bytes.
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1.7 Advanced Event Counting and Sequencing
The count and sequence options define rules for data recording sessions. These options 
configure and control the order of events that have been selected for triggering or filtering.

By utilizing this feature, designers can specify a specific sequence of up to seven events 
that must occur before the Analyzer triggers and finishes capturing data. This allows 
designers to pinpoint certain types of events for recording. Without this feature, designers 
must scroll through potentially megabytes of recorded data to locate a specific sequence 
or occurrence of a sequence that can take hours to locate before being able to begin 
analyzing the data of interest.

1.8 BusEngine Technology
The LeCroy BusEngine Technology is at the heart of the Analyzer. The BusEngine core 
uses state-of-the-art Electrically Programmable Logic Device (EPLD) technology and 
incorporates both a real-time recording engine and configurable building blocks that 
implement data/state/error detection, triggering, capture filtering, external signal 
monitoring, and event counting and sequencing. Like the flash-memory-based firmware 
that controls its operation, all BusEngine logic is fully field upgradeable, using 
configuration files.

1.9 Flexible 3.0 Calibration
Each link can be calibrated with respect to received equalization and gain.
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Chapter 2:  General Description
2.1 System Components/Packing List

These system components are on the packing list:

• Voyager M3 Analyzer Exerciser System
• AC power cable
• USB cables (five)
• Installation CD-ROM, including documentation
• Micro to Standard USB adapter
• Mini to Standard USB adapter
• Quick Start Guide
Product documentation is on the Installation CD-ROM.

2.2 PC Requirements
Please refer to the USBProtocolSuite_Readme.html file on the installation CD for the 
most current PC and operating system requirements.

2.3 Analyzer
The Analyzer is shown in the figure. 

Figure 2.1 Front

Note: The rear has only a power connector.

The Analyzer has the following features:

Power Switch (0/1)

Status LED (blue if system successfully initializes
 red if hardware failure
 green while initializing)
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Analyzer Ports A (downstream) and B (upstream)
Analyzer LEDs

Rec - Recording (red if recording enabled)
3.0 - USB 3.0 (green if traffic detected)
2.0 - USB 2.0 (yellow for Low and Full Speed)

(green for Hi Speed)

Exerciser Ports A (downstream) and B (upstream)
Exerciser LEDs

Gen - Generating (green if generating enabled)
Rec - Recording (red if recording enabled)
3.0 - USB 3.0 (green if traffic detected)
2.0 - USB 2.0 (yellow for Low and Full Speed)

(green for Hi Speed)

A (downstream) - MMCx plug connectors for interfacing
B (upstream)       with USB 3.0 signals

Tx + - Transmit pair
Rx + - Receive pair

Clock A (downstream) - MMCx plug connectors for interfacing
Clock B (upstream)        with external clock source or sink

In - Connects to an external reference clock.
Out- Provides reference clock output.

Trigger
 In - SMA external trigger input.
Out- SMA external trigger output.

USB - Type B connector for connection to host computer

ETHERNET- Gigabit Ethernet connector for connection to host computer

Note: The rear panel has only a power connector.

Warning: Do not open the Voyager M3 enclosure. No operator serviceable 
parts are inside. Refer servicing to LeCroy customer care.
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2.4 Specifications
The Analyzer has the following specifications. 

Power Requirements
90 to 254 VAC, 47 to 63 Hz (universal input), 100 W maximum 

Environmental Conditions

Probing Characteristics

Switches

Recording Memory Size
1 GB or 4 GB for traffic data capture, timing, state and other data.

Operating Temperature 0 to 55 °C (32 to 131 °F)

Storage Range -20 to 80 °C (-4 to 176 °F)

Operating Humidity 10 to 90%, non-condensing

Operating Altitude Up to 6560 feet (2000 meters)

Connection High Speed USB Connectors
Standard cables
MMCx connectors for USB 3.0

Power On/off
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Host Compatibility
Works with any PC equipped with a functioning USB port and running the 
Microsoft® Windows® XP, Windows Vista™ 32, or Windows Vista 64 operating system.

Required Setup
Microsoft Internet Explorer, Version 5 or newer.

Hardware
Processor: For optimum performance, use processors of the Intel® Core 2 Duo or other 
compatible processors with clock speed of 2 GHz or higher. 

Memory: Minimum is 512 MB of RAM. For best performance, use physical RAM at least 
as large as the size of the recording buffer, up to 3 GB.

Hard Disk: 25 MB of free hard disk space is required for the installation. Additional disk 
space is needed for operation of applications and storing recorded data in files, each of which 
can be as much as 2 GB. Hard disks with fast access times are recommended.

Display: Resolution of 1024 x 768 with at least 24-bit color depth is minimum.

Connectivity: For Hi-Speed uploads, a USB 2.0 interface is recommended (USB 1.1 is 
minimum). This is not required if the application is used only to view pre-recorded traces. 
Alternatively, Ethernet can be used on a DHCP network.
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Chapter 3:  Installation
The Analyzer software installs on a Microsoft® Windows® XP, Windows Vista™ 32, or 
Windows Vista 64 personal computer system. 

3.1 Installing the Analyzer Software on the PC
Note:  You must install the software before connecting the Analyzer to the host 

machine for the first time.

Install the software on the PC administering the Analyzer: 

Step 1 Insert the Installation CD into the CD drive of the PC that administers the 
Analyzer. 

Step 2 Follow the on-screen installation instructions to install the application on the PC 
hard disk.

3.2 Setting Up the Analyzer - USB Connection
To set up the Analyzer using a USB connection:

Step 1 Connect the AC power cord to the rear of the Analyzer and to a 100-volt to 
240-volt, 50-Hz to 60-Hz, 100-W power outlet.

Note:  The Analyzer is capable of supporting supply voltages between 100 volts 
and 240 volts, 50 z or 60 Hz, thus supporting all supply voltages around the 
world.

Step 2 Connect the USB port to a USB port on the PC using the LONG (6-foot/2-meter) 
USB cable.

Step 3 Insert the Installation CD.

Step 4 Turn on the power switch.

Note:  At power-on, the Analyzer initializes itself in approximately ten seconds and 
performs an exhaustive self-diagnostic that lasts about five seconds. If the 
diagnostics fail, call LeCroy Customer Support for assistance.

Step 5 Click Next after you see the Add New Hardware Wizard window.

Step 6 Follow the Microsoft® Windows® on-screen Plug-and-Play instructions for the 
automatic installation of the Analyzer as a USB device on your analyzing PC (the 
required USB files are included on the Installation CD)

Step 7 Click Finish when you see the message that says “Windows has finished 
installing the software that your new hardware requires” and the file 
VoyagerM3.inf has been installed in your PC.

Step 8 Check Analyzer setup in the “Application Startup” section (See “Application 
Startup” on page 17).

Warning!  Do not change from USB to Ethernet, or back, without power cycling 
analyzer.
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3.3 Setting Up the Analyzer - Ethernet Connection
To set up the Analyzer using an Ethernet connection:

Step 1 Connect the provided AC power cord to the rear of the Voyager M3 and to a 
100-volt to 240-volt, 50-Hz to 60-Hz, 100-W power outlet.

Note:  The Analyzer is capable of supporting supply voltages between 100 volts 
and 240 volts, 50 z or 60 Hz, thus supporting all supply voltages around the 
world.

Step 2 Insert the Installation CD.

Step 3 To use a DHCP network, make sure that the PC is connected to a DHCP 
network, then connect the Ethernet port on the Analyzer to a DHCP network. 
 
Note: If the DHCP network uses a Firewall, you must set the Firewall to allow the 
Analyzer device on the network.  
 
Note: Direct connection from the Ethernet port on the PC to the Ethernet port on 
the Analyzer is supported in this release. See “IP Settings” on page 19.

Step 4 Turn on the power switch.

Note:  At power-on, the Analyzer initializes itself in approximately ten seconds and 
performs an exhaustive self-diagnostic that lasts about five seconds. If the 
diagnostics fail, call LeCroy.

Step 5 Complete Analyzer setup in the “Application Startup” section (See “Application 
Startup” on page 17).

Warning!  Do not change from USB to Ethernet, or back, without power cycling 
analyzer.
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3.4 Application Startup
To start the application, launch the LeCroy USB Protocol Suite program from the 
Start Menu:  
Start > Programs > LeCroy > USB Protocol Suite > USB Protocol Suite. 
to open the main window.

You can use the software with or without the system connected to the host. Without the 
Analyzer, the program functions as a trace viewer to view, analyze, and print trace files.

Confirm Proper Hardware Installation and USB or Ethernet 
Connection

USB Connection
For USB connection, after you open the USB Protocol Suite application, confirm proper 
installation and USB connection by selecting About from the Help menu to view the 
Software Version, Firmware Version, BusEngine™ Version, and Unit Serial Number in 
the About window.

Ethernet Connection
For Ethernet connection, after you open the USB Protocol Suite application, confirm 
proper installation and Ethernet connection using the Analyzer Devices dialog and the 
About window.
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Analyzer Devices
To display the available Analyzer Devices, select Setup > All Connected Devices to 
display the Analyzer Devices dialog.

The dialog displays the Device, Location, and Status.

You can click:

• About to display device information (see “Software, Firmware, and 
BusEngine Revisions” on page 197).

• Update Device (see “Manual Updates to Firmware, BusEngine, and 
Serdes BusEngine” on page 202)

• Update License (see “Updating the Software License” on page 204)
• Connect to display the Connection Properties dialog, in which you can set the 

system to: 
- Automatically connect to the device. 
- Ask to connect to the device. 
- Take no action.

• Add Device to display the Add Ethernet Attached Device dialog, in which you 
can enter an IP Address.

• IP Settings to use a DHCP or Static IP address.

To refresh the list of devices, click Refresh Device List.

Before starting recording, select the Analyzer you want to participate in recording.
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IP Settings
If you are connected to a device, you can change the IP settings:

• DHCP automatically assigns an IP address. DHCP is the default.
• Static IP prompts you to enter a specific IP address.

To change from DHCP to Static IP while connected to a device:

Step 1 Select Setup > All Connected Devices from the menu bar to display the 
Analyzer Devices dialog. 

Note: If you are not connected to a device, the IP Settings command is grayed out.
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Step 2 Select the device to use in the recording, then click the IP Settings button to 
display the Device IP Settings dialog.

Two radio buttons are available:
• Obtain IP address automatically (DHCP) [default]
• Use the following IP Address (Static IP)
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Step 3 To change to Static IP, click the Static IP radio button.

Enter the IP Address.
Enter the Subnet Mask.
Enter the Default Gateway.

Click Apply to get a success message and return to the Analyzer Devices 
dialog.

Note:  You can let the system Suggest static IP settings (IP address and 
subnet mask.

Step 4 Click Close to close the dialog and use the device with a Static IP address. 
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Analyzer Network
For Ethernet, to display the computers and analyzers on the local network, select  
Setup > Analyzer Network to display the Analyzer Network dialog.

The dialog displays the Computers on the network and the Analyzer devices connected 
to the computers.

You can click Add to display the Add Analyzer Network Node dialog, in which you can 
select a Computer on the network 

You can also Remove a selected computer or Reconnect a selected computer.
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USB 3.0 Device/Host Signal Parameters
For USB, to add, remove, edit, load (from a comma-delimited .csv file), or save (as a 
comma-delimited .csv file) USB 3.0 devices and to calibrate USB 3.0 connections, select 
Setup > USB 3.0 Device/Host Signal Parameters to display the  
USB3 Device -> Analyzer -> Host Signal Profiles dialog.

The dialog lists the Device Name, Device Cable, Host Name, Host Cable, and to what 
the Profile Signal Settings apply. It also shows Device-to-Analyzer and Host-to-Analyzer 
custom signal settings.
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To add a device, click Add to display the USB3 Device -> Analyzer -> 
Host Signal Parameter Profiles dialog.

The dialog allows you to Set Device “Current” or Read from Analyzer.
The dialog allows you to Set Host “Current” or Apply to Analyzer.
You can enter Device to Analyzer Signal Settings:

• Device Name
• Device Cable ID
• Input Signal Equalization (ISE) Settings: short, medium and long time 

constant (Current, Off, Minimum, Moderate, or Maximum)
• Pre-Emphasis Settings: short and long time level (0 to 15) and  

short and long time decay (0-7)
• Output Power Level: Current or 213 mV to 1294 mV

You can enter Host to Analyzer Signal Settings:

• Host Name
• Host Cable ID
• Input Signal Equalization (ISE) Settings: short, medium and long time 

constant (Current, Off, Minimum, Moderate, or Maximum)
• Pre-Emphasis Settings: short and long time level (0 to 15) and  

short and long time decay (0-7)
• Output Power Level: Current or 213 mV to 1294 mV

You can also Load the default settings or Load the last applied settings.
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3.5 Your First USB Recording
After installing and launching the software, you can test the system by performing the 
following steps: 

Step 1 Connect a USB cable to each of the two connectors on the Analyzer module, 
then connect the other ends to the USB device under test and USB host system.

Step 2 Select Recording Options under Setup on the Menu Bar.

Step 3 Select the General tab to display the following dialog box showing factory default 
settings such as Snapshot and 4 MB buffer size. For the first recording, you can 
leave these settings unchanged. 

Note:  Items not supported on Voyager M3 are greyed out.

Step 4 Click OK to activate the recording options you selected.

Step 5 Turn on the USB devices that are to be tested and cause them to generate USB 
traffic. 

Step 6 Click  on the Tool Bar.

The system starts to record the USB traffic immediately. After 4 MB of traffic are 
recorded, the Analyzer uploads the data and displays the packets in the trace 
window.
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Step 7 To terminate recording before the snapshot automatically completes, 
 
click  on the Tool Bar.

When the recording session is finished, the traffic is uploaded from the Analyzer 
to the hard drive on your PC as a file named data.usb or the name you assigned 
as the default filename. While the file is being uploaded, you should see a brown 
progress bar at the bottom of the screen. When the bar disappears, it indicates 
that the data has been uploaded to disk.

Step 8 To save a current recording for future reference, select Save As under File on 
the Menu Bar.

OR

Click  on the Tool Bar to display the standard Save As screen. 
Give the recording a unique name and save it to the appropriate directory.



USB Protocol Suite User Manual Chapter 3: Installation

LeCroy Corporation  27

Trace View Features
After a moment, the recording terminates and the results display.

• The packet view display makes extensive use of color and graphics to fully 
document the captured traffic.

• Packets are shown on separate rows, with their individual fields both labeled 
and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped (with a 
resolution of 2 ns on 3.0 signalling), and highlighted to show the transmitted 
speed (low-speed, full-speed, high-speed, or superspeed).

• Display formats can be named and saved for later use. 
• Data fields can be collapsed to occupy minimal space in the display. 

The display software can operate independently of the hardware and so can function as 
a stand-alone Trace Viewer that may be freely distributed. 

You can start the application from the Desktop or from the installed directory. 

The software may be used with or without the Analyzer. When used without the Analyzer, 
the program functions in a Trace Viewer mode to view, analyze, and print captured 
protocol traffic.

When the program is used with the Analyzer attached to the computer, you can set trigger 
conditions, record, monitor and analyze the activity of your USB bus.
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Chapter 4:  Software Overview
The Trace Viewer is an application that may be used with or without the Analyzer box. 
When used without an Analyzer box, the program functions in a Trace Viewer mode to 
view, analyze, and print captured protocol traffic. The software also allows you to view 
trace files created by the LeCroy USB Chief™, USB Advisor™, USB Detective™, 
USB Inspector™, and USB Tracer™/Trainer™. Opening a file created with either of 
these Analyzers displays a screen asking if you want to convert the old file to the new 
format under the name <filename>_convert.usb.

When the program is used with the Analyzer attached to the computer, you can monitor 
and analyze the activity of your USB branch from either of the USB ports on the front of 
the Analyzer.

4.1 Starting the Program
To start the USB Protocol Suite program:

Step 1 Select Start > Programs > LeCroy > USB Protocol Suite >  
USB Protocol Suite.

4.2 Tooltips
Tooltips provide useful information about cells in the trace and buttons in the application. 
To display a tooltip, position the mouse pointer over an item.
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4.3 The Main Display Windows
Some of the Main Display window options are familiar Microsoft options. 

Menu Function
File

New .utg file. Creates a new, empty traffic generation file. Available only if a trace 
file (.usb) is open. To edit a .utg file, click Edit as Text in the toolbar.

Open Opens a file.
Close Closes the current file.
Save As Saves all or a range of packets from the current file.
Print Prints part or all of the current traffic data file.
Print Preview Produces an on-screen preview before printing.
Print Setup Sets the options for the current or new printer.
Edit as Text Opens the Script Editor. Available only when a traffic generation file 

(.utg) is open.
Edit Comment Creates or edits the Trace file comment field. 

See “Edit Comment” on page 70.
Check Syntax of .utg 
file

Reads open .utg file and checks syntax for errors. Available only 
when a traffic generation file (.utg) is open.

Export>>
Packets to Text 
(Packet View Format)
Packets to .CSV 
(Comma Separated 
Values for Excel, etc.) 
Format)
Packets to Host Traffic 
Generator Text File 
(.utg)
Packets to Device 
Emulation Traffic 
Generation Text File 
(.utg)
Data

Saves all or part of a trace to a text file or generator file.
Saves trace as text file in Packet View Format. 

Saves trace as a comma-separated-values text file for use with 
Microsoft® Excel. 
 

Saves trace as script file that can be used by a Generator to 
generate a trace. 

Exports packets to Device Emulation files. This option does not 
export transactions. 
 

Exports Transfer data as text or binary file.
Note: Export is supported only for USB 2.0 traffic.

Merge Trace Files Merges two simultaneously recorded files into a single file. (This 
command does not work if the files were recorded at different times).

Import Imports data from a  .vcd file to a BusEngine™ data file. 
If you have exported simulations to a defined  .csv format, you can 
import data from the  .csv file to a BusEngine™ data file. To use this 
feature, you must contact support for information on how to export to  
a specific-format  .csv file and then import the file. 

Compare Endpoint 
Data

Allows you to select two endpoints of different directions with the 
same address and verify that the data OUT/IN is identical to the data 
IN/OUT from the other endpoint. Used when running echo-types of 
tests for data integrity. Available only when a trace file (.usb) is 
open. (2.0 only)

Exit Exits the program.
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Setup
Display Options Provides display options such as color, formats, and filters. 

See “Display Options” on page 87.
Recording Options Provides setup options for recording, triggering events and filtering. 

See “Recording Options” on page 147.
Update Device Updates the BusEngine™ and Firmware manually. 

See “Manual Updates to Firmware, BusEngine, and 
Serdes BusEngine” on page 202.

Analyzer Network Opens a dialog box for browsing to local and networked analyzers. 
Within the dialog, click Add to browse. The dialog lists PCs that are 
on the LAN. If a PC has an analyzer attached to it, and if DCOM 
permissions have been set on the selected PC, clicking Select 
establishes a connection. 
See “Analyzer Network” on page 22.

All Connected 
Devices

Opens a dialog box with a list of analyzers connected to the host PC. 
Lets you select an analyzer and update the BusEngine, Firmware, 
and licensing information. 
See “Analyzer Devices” on page 18.

USB 3.0 Device/ 
Host Signal 
parameters

Adds, removes, edits, loads, and saves USB 3.0 devices and lists 
the device name, device cable, host name, host cable, and to what 
the Profile Signal Settings apply.  
Used to calibrate 3.0 connections. Also shows custom 
device-to-analyzer and host-to-analyzer signal settings. 
See “USB 3.0 Device/Host Signal Parameters” on page 23.

Record
Start Causes the Analyzer to begin recording USB activity.
Stop Causes the Analyzer to stop recording.
Upload Again Allows you to upload a different portion of the captured trace if the 

previous upload was only partially uploaded. 
Reset SuperSpeed 
Capture Engine

For USB 3.0 traffic capture, in some cases the analyzer might not 
correctly lock onto the 5-Gbps signals on power up, or it may unlock 
after a long period of usage. To issue a soft reset to the SuperSpeed 
capture engine, select this command.  Note: After performing the 
reset, you must retrain the link on your devices.

Generate (see “Traffic Generation (2.0)” on page 173)
Start/Stop Starts traffic generation. Once traffic generation has begun, the Start 

command becomes Stop and lets you stop traffic generation.

IntelliFrame 
Generation Mode

Sets the mode of generation to IntelliFrame. Use before Start. (2.0 
only)

Bitstream Generation 
Mode

Sets the mode of generation to bitstream. Use before Start. (2.0 
only)

Repeat Mode Allows you to repeat once, a specified number of times, or an infinite 
number of times using the Generation Repeat Mode window. (2.0 
only)

Menu Function
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Report
File Information Displays information about the recording such as the number of 

packets and triggering setup. 
See “File Information” on page 118.

Error Summary Summarizes the errors throughout the recording. Allows for fast 
navigation to packet with errors.. 
See “Error Summary” on page 119.

Timing Calculations Calculates timing between two packets and bus utilization. 
See “Timing Calculations” on page 120.

Data View Shows packet information. 
See “Data View” on page 140.

Traffic Summary Summarizes the numbers and types of errors, packets, transactions, 
split transactions, and transfers that occurred in the open trace. 
See “Traffic Summary” on page 121.

Bus Utilization Displays graphs of packet length, bus usage, and bus usage by 
device.  
See “Bus Utilization” on page 122.

Link Tracker Opens a window for displaying a detailed chronological view of 
traffic. The window provides view and navigation options. 
See “Link Tracker (3.0)” on page 134.

Spec View Shows packet header information and other items, in a view that 
matches the USB 3.0 specification. 
See “Spec View (3.0)” on page 139.

Search (see “Searching Traces” on page 71)
Go to Trigger Positions the display to show the first packet that follows the trigger 

event.
Go to Packet/ 
Transaction/Transfer

Positions the display to the packet/transaction/transfer number 
selected in the Go to Packet/Transaction/Transfer menu.

Go to Marker » Positions the display to the selected marked packet.
Go to USB2.0» Positions the display to the selected event, condition, value, or type.
Go to USB3.0» Positions the display to the selected event, condition, value, or type.
Find Allows complex searches on multiple criteria. 

See “Find” on page 82.
Find Next Repeats the previous Find operation.
Search Direction Allows the search direction to be changed from Forward to 

Backward or vice versa. 

Menu Function
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View
Toolbars Displays list of available toolbars. 

See “Resetting the Toolbar” on page 38.
Analyzer Network  
Chat Bar

Opens a dialog that allows users to conduct chat sessions over an 
IP LAN. In order to send and receive electronic text messages, each 
user must be working with a PC that is on an IP LAN and also 
attached to an analyzer.

Status Bar Switches display of the Status Bar on or off. 
See “Status Bar” on page 39.

Real-time Statistics Allows you to view traffic statistics as they occur. 
See “Real Time Monitoring” on page 129.

Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed packets within the window.
Show USB 2 Traffic 
Only

Displays only USB 2.0 traffic.

Show USB 3 Traffic 
Only

Displays only USB 3.0 traffic.

Hiding USB 2 Traffic Hides.
• SOF’s: Start of Frames
• NAK’s: NAK’ed Transactions
• Devices: Packets belonging to specified devices by 

address and endpoint
• Chirps: Chirp-K and Chirp-J Bus conditions (these are 

recorded only) 
Hiding USB 3 Traffic Hides:

• Link Commands (Flow Control)
• Link Training Sequences (TS1, TS2, TSEQ)
• Logical Idle Packets
• Upstream Packets
• Downstream Packets
• Skip Sequences
• ISO Time Stamp Packets
• Inter-Packet Symbols
• Link Commands (Other than Flow Control)
• LMP Packets
• Electrical Idles
• LFPS Packets

Apply Decoding 
Scripts

Decoding scripts set the values of the display and recording options 
for optimum views of trace information from specific vendors or 
classes of data. This menu option allows you to select the vendor or 
class of data for the request recipients and endpoints listed in the 
Request Recipients and Endpoints menu. You can keep the settings 
across recordings. 
See “Decode Requests” on page 97.

Menu Function
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Packet Level Displays Packets.
Transaction Level Displays Transactions.
Split Transaction Level Displays Split Transactions.
Transfer Level Displays Transfers.
HWA Segment Level Displays Host Wire Adapter Segments
HWA Transfer Level Displays Host Wire Adapter Transfers
DWA Segment Level Displays Device Wire Adapter Segments
DWA Transfer Level Displays Device Wire Adapter Transfers
PTP Transaction 
Level

Displays PTP Transactions

PTP Object Transfer 
Level

Displays PTP Objects

PTP Session Level Displays PTP Sessions
Refresh Decoding Forces the software to re-decode transactions and transfers. Useful 

if you have applied a decoding mapping which helps fully decode a 
sequence of transfers, as is the case with Mass Storage decoding.

Window
New Window Switches display of the Tool Bar on or off.
Cascade Displays all open windows in an overlapping arrangement.
Tile Horizontal Displays all open windows in a above-below arrangement.

Tile Vertical Displays all open windows in a side-by-side arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Help
Help Displays online help. You can also select F1.

Update License Opens a dialog box for updating your LeCroy license.  
See “Updating the Software License” on page 204.

Display License 
Information

Displays information related to licensing. 
See “License Information” on page 203.

Register Product 
Online

Register at the LeCroy website. 
See “Registering Online” on page 204.

Check for Updates Use the Internet to analyze your system for licensed updates. You 
can set the system to automatically check for updates at application 
startup in the LeCroy USB Protocol Suite Software Update window. 
See “Software Updates” on page 198.

About Displays version information about the Voyager M3 and the 
USB Protocol Suite. 
See “Software, Firmware, and BusEngine Revisions” on page 197.

Menu Function
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4.4 View Options
You can hide, display or reset toolbars by selecting View > Tool bars from the menu bar.

Tool Bar

The Tool Bar provides quick and convenient access to the most popular program 
functions. Tool tips briefly describe the functionality of each icon and menu item as the 
mouse arrow is moved over the icon/item. 

Files and Searches

Zoom and Wrap

Miscellaneous

Open file Find (see “Find” on page 82)

Save As Find Next

Zoom In Zoom Out

Wrap

Display Realtime Statistics. 
See “Real Time Monitoring” on page 
129

Assign High Level Decodes. 
See “Decode Requests” on page 97.
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Reports

Recording and Traffic Generation (see “Traffic Generation (2.0)” on page 173)

Display/Hide (see “Reading a Trace” on page 45)

File Information Report 
See “File Information” on page 118.

Error Report 
See “Error Summary” on page 119.

Timing and Bus Usage Calculations 
See “Timing Calculations” on page 
120.

Traffic Summary 
See “Traffic Summary” on page 121.

Data View 
See “Data View” on page 140.

Bus Utilization 
See “Bus Utilization” on page 122.

Link Tracker 
See “Link Tracker (3.0)” on page 
134.

Spec View 
See “Spec View (3.0)” on page 139.

Open the Navigator bar 
See “Using the Trace Navigator” on 
page 141.

Manual Trigger
Start or Stop Traffic Generation 
(available if you have the Traffic 
Generation module).

Repeat Upload Bitstream and Intelliframe modes

       Start Recording Set up Recording Options

Stop Recording Set up Display Options

Repeat Mode. This button becomes 
active when a traffic generation file 
(*.utg) is open.

Display Packets 
See “Trace View Features” on page 
45.

Display Device Wire Adapter 
Segments 
See “Switch to Device Wire Adapter 
Segment View” on page 65.

Display Transactions 
See “Switch to Transactions View” 
on page 57.

Display Device Wire Adapter 
Transfers 
See “Switch to Device Wire Adapter 
Transfer View” on page 65.

Display Split Transactions 
See “Switch to Split Transaction 
View” on page 61.

Display PTP Transactions 
See “Switch to PTP Transactions” on 
page 66.

Display Transfers 
See “Switch to Transfer View” on 
page 61.

Display PTP Objects 
See “Switch to PTP Object 
Transfers” on page 66.
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USB 2.0 and USB 3.0

USB 2.0 Display/Hide

USB 3.0 Display/Hide

Display Host Wire Adapter 
Segments 
See “Switch to Host Wire Adapter 
Segment View” on page 64.

Display PTP Sessions 
See “Switch to PTP Sessions” on 
page 67.

Display Host Wire Adapter Transfers 
See “Switch to Host Wire Adapter 
Transfer View” on page 65.

Display USB 2.0 traffic only. Display USB 3.0 traffic only.

Hide SOFs. Hide Devices

Hide NAK’ed transactions. Hide Chirps

Hide Link Commands 
(Flow Control). Hide ISO Time Stamp Packets.

Hide Link Training Sequences 
(TS1, TS2, TSEQ).

Hide Inter-Packet Symbols 
(unexpected packets).

Hide Logical Idle Packets.
Hide Link Commands  
(other than Flow Control).

Hide Upstream Packets. Hide LMP Packets.

Hide Downstream Packets. Hide Electrical Idles.

Hide Skip Sequences. Hide LFPS Packets.



Chapter 4: Software Overview USB Protocol Suite User Manual

38 LeCroy Corporation

Resetting the Toolbar
From time to time (such as following a software upgrade), it is possible for the buttons on 
the toolbar to not match their intended function. You can reset the toolbar by performing 
the following steps:

Step 1 Select View > Tool bars from the menu bar.

Step 2 Select Customize from the submenu to display the Customize dialog box. 

Step 3 Select the Toolbars tab to display the Toolbars page of the Customize dialog 
box. 

Step 4 Click the Reset All button.

The toolbar resets to the factory defaults.
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4.5 Status Bar
The Status bar is located at the bottom of the main display window. Depending on the 
current activity, the bar can be divided into as many as four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays a Recording 
Progress Indicator: 

As recording progresses, the Progress Indicator changes to reflect the recording 
progress graphically:

In the Progress Indicator, a black vertical line illustrates the location of the Trigger 
Position you selected in Recording Options. 

• Pre-Trigger progress is displayed in the field to the left of the Trigger Position 
in the before-Trigger color specified in the Display Options. 

• When the Trigger Position is reached, the progress indicator wiggles as it 
waits for the trigger. 

• After the trigger occurs, the field to the right of the Trigger Position fills in the 
after-Trigger color specified in the Display Options. 

• When recording is complete, the upper half of the progress indicator fills in 
white, indicating the progress of the data upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger Event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate that not all 
the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger Event, the Progress Bar adjusts 
accordingly to begin uploading the most recently recorded data.

The Progress Bar fills with color in proportion to the specified size and actual rate at which 
the hardware is writing and reading the recording memory. However, the Progress 
Indicator is normalized to fill the space within the Status Bar.
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Recording Status
During recording, the current Recording Status is displayed in the next segment. When 
you activate the Record function, this segment flashes one of the following messages 
(depending on the selected Recording Options):

• Trigger?
• Triggered!
• Uploading

After recording stops, 

• The flashing message changes to Uploading data–x% done (x% indicates 
the percentage completion of the data uploading process). 

• The traffic data is copied to disk (overwriting any previous version of this file) 
using the default file name data.usb. You can also create a file name of your 
choice by specifying one in the Recording Options dialog box.

To abort the upload process: 

• Press Esc on your keyboard
OR

• Again click  in the Tool Bar. 
You are asked if you want to keep or discard the partially uploaded data.

Note:  While uploading is in progress, clicking the stop button again brings up a 
dialog opens a dialog that allows you to do a partial upload, flush the current 
file, keep what has uploaded at this point, and to continue uploading.

The Partial Upload button is enabled when you have partially uploaded data. When you 
click Partial Upload, a dialog box appears that gives you options on what portion of data 
you want to upload again. 
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When the data is saved, the Recorded Data file appears in the main display window and 
the Recording Status window is cleared. 

• If the recording resulted from a Trigger Event, the first packet following the 
Trigger (or the packet that caused the Trigger) is initially positioned second 
from the top of the display.

• If the recording did not result from a Trigger Event, the display begins with the 
first packet in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays Recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note:  If packets are filtered from the recording or data are truncated, the recording 
activity is reduced.

Search Status
The rightmost segment displays the current search direction: Fwd (forward) or Bwd 
(backward). Change the search direction from the Search Menu or double-click the 
Search Status segment. 



Chapter 4: Software Overview USB Protocol Suite User Manual

42 LeCroy Corporation

4.6 Navigation Tools
You can zoom in and out, and wrap packets/transactions/transfers to fit within the screen 
using the following buttons:

Zoom In
Zoom In increases the size of the displayed elements, allowing fewer (but larger) packet 
fields per screen. 

• Click  on the Tool Bar.

Zoom Out
Zoom Out decreases the size of the displayed elements, allowing more (but smaller) 
packet fields per screen. 

• Click  on the Tool Bar.

Wrap
Select Wrap to adjust the Trace View so that packets fit onto one line. If a packet is longer 
than the size of the window, the horizontal scroll bar can be used to see the hidden part 
of the packet.

• Click  on the Tool Bar or select Wrap under View on the Menu Bar.
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4.7 Analyzer Keyboard Shortcuts
Several frequently-used operations are bound to keyboard shortcuts. 

Table 1: Keyboard Shortcuts
Operation Key Combination

Trace Navigation

Find Next F3

Search Backwards Ctrl+B

Search Forwards Ctrl+F

Jump to First Packet Ctrl+Home

Jump to Last Packet Ctrl+End

Go to Any Error Shift+E

Go to Channel 0 Ctrl+Shift+0

Go to Channel 1 Ctrl+Shift+1

PID

Go to ACK Shift+A

Go to DATA0 Shift+0

Go to DATA1 Shift+1

Go to DATA2 Shift+2

Go to DATAx Shift+D

Go to IN Shift+I

Go to MDATA Shift+M

Go to NAK Shift+N

Go to NYET Shift+Y

Go to OUT Shift+O

Go to PING Shift+G

Go to PRE/ERR Shift+P

Go to SETUP Shift+S

Go to SOF Shift+F

Go to SPLIT Shift+X

Go to STALL Shift+L

Go to EXT Shift+R
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Bus Conditions

Go to Reset Shift+T

Go to Resume Shift+6

Go to SE0 Shift+Z

Go to SE1 Shift+7

Go to Keep-Alive Shift+5

Go to Suspend Shift+U

Go to Chirp Shift+C

Go to Full Speed J Shift+J

Go to Full Speed K Shift+K

OTG

Go to SRP Ctrl+Q

Go to HNP Shift+H

Go to VBus Voltage Change Shift+V

Go to OTG Host A Ctrl+Shift+A

Go to OTG Host B Ctrl+Shift+B

Misc.

Marker Menu Ctrl+M

Open File Ctrl+O

Print… Ctrl+P

Record Ctrl+R

Stop Recording Ctrl+T

Open Display Options dialog Ctrl+Shift+D

Open Recording Options dialog Ctrl+Shift+R

Hide SOFs Ctrl+Shift+S

Hide NAKs Ctrl+Shift+N

Hide Chirps Ctrl+Shift+C

Apply Decoding Scripts Ctrl+Shift+Y

Set Quick Timing Marker Start Ctrl+Left-click-mouse

Set Quick Timing Marker End Ctrl+Shift+Left-click-mouse
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Chapter 5:  Reading a Trace
5.1 Trace View Features

The Trace View has these features:

• The packet view display makes extensive use of color and graphics to fully 
document the captured traffic.

• Packets are shown on separate rows, with their individual fields both labeled 
and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped (with a 
resolution of 8 ns), and highlighted to show the transmitted speed (low-speed, 
full-speed or high-speed).

• Display formats can be named and saved for later use. 
• Pop-up Tool Tips detail the contents of packet fields.
• Data fields can be collapsed to occupy minimal space in the display, and you 

can zoom in and out to optimize screen utilization. 
• The display software can operated independently of the hardware and so can 

function as a stand-alone Trace Viewer that may be freely distributed.
• High Speed SOFs display Microframes (shown below.)

3.0 Packets
USB 3.0 has the following packet types:

• Link Commands (Flow Control).
• Link Training Sequences (TS1, TS2, TSEQ).
• Logical Idle Packets
• Upstream Packets
• Downstream Packets
• Skip Sequences.
• ISO Time Stamp Packets
• Inter-Packet Symbols (unexpected packets)
• Link Commands (other than Flow Control)
• LMP Packets
• Electrical Idles
• LFPS Packets

Microframes
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5.2 Set Marker
You can define a unique Marker for each packet. 

To place a marker on a packet: 

Step 1 Right-click Packet # for the packet you wish to mark to display the Packet menu: 

Step 2 Select Set Marker.
You see the Edit Marker Comment window where you can enter a unique 
comment about this packet.:

Step 3 Enter your comment. 

Step 4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge of the packet # 
block: 
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5.3 Edit or Clear Marker
To clear or edit the comments associated with a packet marker: 

Step 1 Right-click Packet # to display the Packet menu: 

Step 2 To edit the Marker Comment, select Edit Marker Comment to display the 
Edit marker comment window. Edit the comment, then click OK: 

Step 3 To clear a Marker, click Clear Marker.
The vertical red Marker bar disappears.
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5.4 Set or Clear Quick Timing Markers
Quick Timing Markers provide immediate time deltas and bandwidth calculations. If the 
Start is placed on a packet that contains an Address and Endpoint, the bandwidth for that 
combination is displayed in the Status Bar below the trace data.

To set or clear quick timing markers: 

Step 1 Right-click Packet to display the Packet menu: 

Step 2 To set the start quick timing marker, select Set Start Quick Timing Marker to 
mark the packet with a red S.

Step 3 To clear a marker, right-click Packet to display the Packet menu, then click 
Clear Quick Timing Marker.
The red S disappears.
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Step 4 To set the end quick timing marker, right-click Packet to display the Packet menu, 
then select Set End Quick Timing Marker to mark the packet with a red E.

The time from marker appears in the Status Bar as the Delta Time from S -> E. 
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5.5 View Raw Bits (2.0)
You can expand a specific packet to view the raw bits in detail. 

To view the raw bits: 

Step 1 Right-click Packet # for the packet you wish to view to display the Packet menu: 

Step 2 Select Show Raw Bits to display the Raw Bits View for that packet: 

Along the top of the Raw Bits View is a linear strip of the logical bit values with 
corresponding field demarcations. Bit stuffing is displayed in color. Below the logical bit 
values is a representation of the D+/D- signaling complete with NRZ encoding. A scroll 
bar assists in navigation of larger packets. Use the two buttons under the label Packet to 
view previous or next packets. Two buttons under the label Zoom allow you to zoom in 
or out on packets.
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5.6 Expanding and Collapsing Data Fields
You can expand a Data field to view it in greater detail or collapse it when you want a more 
compact view. 

Using the Expand/Collapse Data Field Arrows
Data Fields can be easily expanded or collapsed by clicking the small triangular arrows 
on the left side of the data field.

Double-Clicking to Expand/Collapse Data Fields
Data fields can also be expanded or collapsed by double-clicking anywhere in the data 
field.

Expanding or Collapsing All Data Fields
Expand or collapse all data fields by holding down the button for more than a second. 



Chapter 5: Reading a Trace USB Protocol Suite User Manual

52 LeCroy Corporation

Using the Data Field Pop-up Menus
Data fields can expand or collapse by clicking a data field and selecting Expand Data or 
Collapse Data from the pop-up menu.

To expand and collapse data using the menu: 

Step 1 Right-click Data in the Data packet you want to expand or collapse. to display the 
Data Field menu.

If your Data Trace View is currently expanded, you see the Collapse Data 
command:

If your Data Trace View is currently collapsed, you see the Expand Data 
command:

Step 2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted in the format 
you have specified.

Expand or Collapse All Data Fields
All data fields can be expanded or collapsed by selecting Expand All Data Fields or 
Collapse All Data Fields from the data field pop-up menus.
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5.7 View Data Block
The data field pop-up menu has an option for viewing the raw bits in a data field. 

To view these bits: 

Step 1 Click the data field to open the data field pop-up menu. 

Step 2 Select View Data Block or the  Data View button to open the Data Block 
dialog box. 

The View Data Block window has options for displaying the raw bits in different 
formats:

• Format: Lets you display data in Hex, Decimal, ASCII or Binary formats
• Show Per Line: Lets you control how many bits are displayed per line
• Bit Order: Most Significant Bit, Least Significant Bit
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5.8 Pop-up Tool-tips
Many fields within the trace display pop-up tool-tips when the mouse pointer is 
suspended over them. These tips provide added details about the field. 

5.9 Hide SOF Packets (2.0)
You can hide Start-of-Frame (SOF) packets that may be uninteresting in a given context 
from a Trace View by clicking the Hide SOF Packets button on the Tool Bar:

• Click  to hide all SOF packets. 

Note:  This also hides low-speed EOPs.

5.10 Hide NAKs (2.0)
You can hide NAKs that may be uninteresting in a given context from a Trace View by 
clicking the Hide NAKs button on the Tool Bar:

• Click  to hide all NAK packets.

5.11 Hide Devices
Click the  button to open a menu for select any address/endpoint combination to be 
hidden. Click the Control (CTRL) key to select multiple values. This menu can be moved 
from its default location and floated in the trace window for later use.

5.12 Hide Chirps (2.0)
Click the  button to hide any Chirped-J or Chirped-K packets recorded in a USB 2.0 
Hi-Speed trace.

5.13 Hide Link Commands (Flow Control) (3.0)
Click the  button to Hide Link Commands (Flow Control).

5.14 Hide ISO Time Stamp Packet (3.0)
Click the  button to Hide ISO Time Stamp Packets.
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5.15 Hide Link Training Sequences (3.0)
Click the  button to Hide Link Training Sequences (TS1, TS2, TSEQ).

5.16 Hide Inter-Packet Symbols (3.0)
Click the  button to Hide Inter-Packet Symbols (unexpected symbols that do not 
form a legal packet or ordered set).

5.17 Hide Logical Idle Packets (3.0)
Click the  button to Hide Logical Idle Packets (which only occur when Idle Filtering 
is Off).

5.18 Hide Link Commands (non Flow Control) (3.0)
Click the  button to Hide Link Commands (other than Flow Control).

5.19 Hide Upstream Packets (3.0)
Click the  button to Hide Upstream Packets.

5.20 Hide LMP Packets (3.0)
Click the  button to Hide LMP Packets.

5.21 Hide Downstream Packets (3.0)
Click the  button to Hide Downstream Packets.

5.22 Hide Electrical Idles (3.0)
Click the  to Hide Electrical Idles.

5.23 Hide Skip Sequences (3.0)
Click the  to Hide Skip Sequences.

5.24 Hide LFPS Packets (3.0)
Click the  button to Hide LFPS Packets.
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5.25 Display 2 Only
Click the  button to display only USB 2.0 traffic.

5.26 Display 3 Only
Click the  button to display only USB 3.0 traffic.
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5.27 Switch to Transactions View
A Transaction is defined in the USB specification as the delivery of service to an 
endpoint. This consists of a token packet, an optional data packet, and an optional 
handshake packet. The specific packets that make up the transaction vary based upon 
the transaction type. 

The program default display mode is Packet View. Before you can view decoded 
transactions, you must switch from Packet View to Transactions View.

To select Transactions View:

Step 1 Click  on the toolbar.

The Trace View screen is re-drawn to display Transactions. 

Note:  This menu selection displays a check next to Show USB transactions when 
you have selected it. When you want to switch back to Packet View mode, 
right-click anywhere in the trace window and then left-click 
Show USB transactions.

Note:  This view also shows Extension Transactions, such as the Link Power 
Management (LPM) transaction defined by the USB 2.0 LPM specification.
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You can also switch to Transaction View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options General 
window.

Step 2 Check Transaction.
Step 3 Click OK.
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5.28 View Decoded Transactions
After you set Display Options, the Trace View screen is re-drawn to display decoded 
transactions in the colors and format you selected.

When you instruct the Analyzer to display USB transactions, the components of each 
transaction are collected from the current recording and are grouped and indented below 
each decoded transaction. Each row shows a transaction with a unique numeration, a 
label, and color-coded decoding of important data.
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Expanded and Collapsed Transactions
You can expand a specific transaction to view its parts, which are grouped and indented 
below the transaction. 

To expand a transaction: 

Step 1 Right-click the transaction number you wish to view to display the 
Expand Transaction menu: 

Step 2 Select Expand This Transaction.

The screen displays the selected transaction in expanded format.

Note:  The Expand/Collapse transaction feature operates as a toggle: when one 
format is active, the other appears as an option on the Expand/Collapse 
drop-down menu. 

To collapse a transaction, perform the same operation and select Collapse This 
Transaction. 

Note that you can choose to expand or collapse 

• Only the selected Transaction
OR

• All Transactions
It is not necessary to use the Expand/Collapse Transactions menu to shift between 
expanded and collapsed views of a transaction. You can double-click the Transaction 
number field to toggle back and forth between collapsed and expanded views.
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5.29 Switch to Split Transaction View
To select Split Transaction View: 

Step 1 Click the  button on the toolbar.

The Trace View screen is re-drawn to display Split Transactions.

You can also switch to Split Transactions View from the Menu Bar:

Step 1 Select Display Options under Setup.

You see the Display Options General window:

Step 2 Check Split Transactions.

5.30 Switch to Transfer View
A Transfer is defined in the USB specification as one or more transactions between a 
software client and its function. USB transfers can be one of four kinds: Control, Interrupt, 
Bulk, and Isochronous. The system can display all four types.

The default display mode is Packet View. Before you can view decoded transfers, you 
must switch from Packet View (or Transaction View) to Transfer View.

To select Transfer View:  

Step 1 Click  on the toolbar.

The Trace View screen is re-drawn to display Transfers.

Note:  Selecting Show USB transfers adds a check next to this menu item. If you 
want to return to Packet View, open the menu and reselect 
Show USB transfers. This action removes the check and returns the 
display to Packet View.

You can also switch to Transfer View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Transfers.
Step 3 Click OK.
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5.31 View Decoded Transfers
After you set Display Options, the Trace View screen is re-drawn to display decoded 
transfers in the colors and format you selected.

When you instruct the Analyzer to display USB transfers, the components of each 
transfer are collected from the current recording and are grouped below each decoded 
transfer. Each transfer row shows a transfer with a unique numeration, a label, and 
color-coded decoding of important data.

Expanded and Collapsed Transfers
You can expand a specific transfer to view its parts, which are grouped and indented 
below the transfer. 

To expand a transfer: 

Step 1 Right-click the transfer number you wish to view to display the Expand Transfer 
menu: 
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Step 2 Select Expand This USB Transfer to display the selected transfer in expanded 
format. 

Note:  The Expand/Collapse transfer feature operates as a toggle: when one format 
is active, the other appears as an option on the Expand/Collapse drop-down 
menu. 

To collapse a transfer, perform the same operation and select 
Collapse This USB Transfer. 
Note that you can choose to expand or collapse 

• Only the selected Transfer
OR

• All Transfers
It is not necessary to use the Expand/Collapse Transfers menu to shift between 
expanded and collapsed views of a transfers. You can double-click the Transfer number 
field to toggle back and forth between collapsed and expanded views.

5.32 Decoding Protocol-Specific Fields in 
Transactions and Transfers

When transfers or transactions are displayed, the fields in setup transactions and in 
control, interrupt, and Bulk transfers do not get decoded (by default) and are shown in 
hexadecimal values. The exceptions are setup transactions and control transfers for 
standard USB device requests, which are always decoded.

To show specific decoding for class- and vendor-specific device requests and endpoints, 
you have to use the decoding association mechanism that is described in Chapter 9 on 
decoding. When you have performed the association, you see the protocol-specific fields 
of transfers and transactions decoded in the trace view.
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5.33 Switch to Host Wire Adapter Segment View
A Host Wire Adapter Segment is one or more transfers between a PC and a host wire 
adapter. To view host wire adapter segments, switch to the Host Wire Adapter Segment 
trace viewing level.

To select the Host Wire Adapter Segment trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Host Wire Adapter Segment.
OR

• Select Setup > Display Options to display the Display Options window, 
check HWA Segment, and then click OK.

The program redraws the trace view. 
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5.34 Switch to Host Wire Adapter Transfer View
A Host Wire Adapter Transfer is one or more wire adapter segments or one or more 
transfers between a PC and a host wire adapter. To view host wire adapter transfers, 
switch to the Host Wire Adapter Transfer trace viewing level.

To select the Host Wire Adapter Transfer trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Host Wire Adapter Transfer.
OR

• Select Setup > Display Options to display the Display Options window, 
check HWA Transfer, and then click OK.

5.35 Switch to Device Wire Adapter Segment View
A Device Wire Adapter Segment is one or more transfers between a PC and a device 
wire adapter. To view device wire adapter segments, switch to the Device Wire Adapter 
Segment trace viewing level.

To select the Device Wire Adapter Segment trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Device Wire Adapter Segment.
OR

• Select Setup > Display Options to display the Display Options window, 
check DWA Segment, and then click OK.

5.36 Switch to Device Wire Adapter Transfer View
A Device Wire Adapter Transfer is one or more wire adapter segments or one or more 
transfers between a PC and a device wire adapter. To view device wire adapter transfers, 
switch to the Device Wire Adapter Transfer trace viewing level.

To select the Device Wire Adapter Transfer trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Device Wire Adapter Transfer.
OR

• Select Setup > Display Options to display the Display Options window, 
check DWA Transfer, and then click OK.
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5.37 Switch to PTP Transactions
The Analyzer supports the Picture Transfer Protocol (PTP) and also supports the 
Media Transfer Protocol (MTP), which is an extension of PTP. The Analyzer can track 
PTP transactions, object transfers, and sessions.

A transaction is a standard sequence of phases for invoking an action. In PTP, an 
Initiator-initiated action provides input parameters, responses with parameters, and 
binary data exchange, and is a single PTP Transaction. Also, a single 
Asynchronous Event sent through the interrupt pipe is a single PTP Transaction. 

The PTP Transaction trace viewing level is the lowest PTP level.

To view PTP transactions, switch to the PTP Transaction trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Transaction.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Transaction, and then click OK.

5.38 Switch to PTP Object Transfers
A logical object on a device has a unique 32-bit identifier (object handle). The 
object handle is also unique for the session (defined below). An object transfer contains 
all the transactions for an object handle. In PTP, all of an object handle’s 
PTP Transactions are a single PTP Object Transfer. 
A PTP Object Transfer can include both PTP Transactions that involve an 
Initiator-initiated action (for example, GetObject, DeleteObject, and GetObjectInfo 
transactions) and PTP Transactions that involve a single Asynchronous Event sent 
through the interrupt pipe. 

The PTP Object Transfer trace viewing level is the middle PTP level.

To view PTP object transfers, switch to the PTP Object Transfer trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Object.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Object, and then click OK.
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5.39 Switch to PTP Sessions
A session is a state of persisting communication between a device and a host during 
which the connection is continuous and the login and other communication parameters 
do not change. A session begins with an OpenSession operation, which establishes the 
communications connection and parameters, and ends with a CloseSession operation. 

A session contains all object transfers (and their transactions), plus all transactions that 
do not belong to object transfers, between an OpenSession operation and a 
CloseSession operation. For PTP, all PTP Object Transfers and all PTP Transactions 
that occur from the OpenSession operation to the CloseSession operation is a single 
PTP Session. 

The PTP Session trace viewing level is the highest PTP level.

To view PTP sessions, switch to the PTP Session trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Session.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Session, and then click OK.
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5.40 Using the Trace Navigator
You can use the Trace Navigator to show the structure of the entire 
trace from different points on the Trace view, thereby refining the 
trace view to a packet range in the trace that is most interesting to 
you. This range can be set by you to show smaller parts of the 
trace. 
 

To display the Navigator bar, click  in the toolbar or select the 
Navigation Bar checkbox in the Display Options General window. 

The Navigator bar can be repositioned in the trace and can be 
oriented horizontally or vertically, docked or undocked by dragging 
the parallel bars at the top or side of the Navigator bar. By default, 
the Navigator bar appears vertically to the right of the trace 
window. 

The Navigator bar represents different types of trace information in 
the order of the packets. The top of each bar corresponds to the 
first packet in the trace, and the bottom corresponds to the last 
packet. The Navigator bar is made up of three parts: 
Pre and Post-Trigger traffic, Errors, and Types of Traffic. 

At any time, a line in the navigator bar of one pixel in height 
represents a fraction of the trace data. If the Navigation bar is 400 
pixels high, then each bar in this example would represent 1/400 
of the trace. If the trace had 4000 packets total, each bar would 
represent ten packets. In the Types of Traffic portion of the 
navigation bar, the color of the bar would be that of the most 
important item in those ten packets. See “Navigator Bar Attributes” 
on page 70. 

Drag the yellow caret, at the top or bottom, to set the packet range. 
When you move the caret, a message shows the packet range.

The blue caret indicates the current packet position in the trace 
view.
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Right-click the Navigator to display the pop-up menu. 

• Pre/Post Trigger, Errors, Types of Traffic: Shows or hides traffic information 
in the Navigator. 

• Legend: Shows or hides Trigger, Error, and Traffic Type categories in the 
Navigator. 

• Set Range to Whole Trace: Resets packet range to the entire trace.
• Set Range near Packet number: Sets the packet range near the packet 

where your mouse pointer is positioned in the Navigator bar. 
• Recent Ranges: Displays a history of ranges that were previously selected. 
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Navigator Bar Attributes

The traffic types are shown in order of importance. For example, if a NAK’d transaction 
occurred in the same sample area as a SOF, the NAK would take precedence, and the 
Navigator would show the black bar. 

5.41 Edit Comment
You can create, view, or edit the 100-character comment field associated with each Trace 
file. These comments are visible in the Windows® Explorer if the Comments attribute is 
included in the Details view. 

Step 1 Select Edit Comment under File on the Menu Bar.

You see the Edit comment for trace file window:

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

You can view comments in Windows Explorer by selecting the Comments attribute. 
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Chapter 6:  Searching Traces
The Search feature provides several options for searching through recorded traffic, 
allowing you to find specific packets based on triggering status, packet number, marking, 
or content. 

To view the Search options: 

• Click Search in the Menu bar to display the Search drop-down menu:

6.1 Go to Trigger
Note:  Go to Trigger is enabled only when a trigger has created the traffic file.

To display a Trigger Event: 

• Select Go to Trigger under Search on the Menu Bar.
The Trace View is repositioned to the first packet following the Trigger event. This packet 
is at the top of the screen.
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6.2 Go to Packet/Transaction/Transfer
To display a specific packet: 

Step 1 From the menu bar, select the command  
Search > Go to Packet/Transaction/Transfer 
to display the Go to Packet/Transaction/Transfer window: 

Step 2 Select the desired viewing level (packet, transaction etc.) from the drop-down 
menu next to the words Go to.

Step 3 Enter the number of the packet you want to display.

Step 4 Click OK. The Trace View is repositioned with the selected packet at the top of 
your screen.

6.3 Go to Marker
To instruct the Analyzer to display a marked packet: 

Step 1 Select Go to Marker under Search on the Menu Bar.

You see a drop-down menu listing the marked packets in that Trace View:

Step 2 Select the desired packet from the displayed list. The Trace View is repositioned 
with the selected packet at the top of your screen.

Note:  The Go to Marker feature functions in conjunction with the Set Marker 
feature. The comments within the parentheses following each marked 
packet are added or edited with the Set Marker feature. Please refer to “Set 
Marker” on page 46.

You can use Ctrl+M to go immediately to the All Markers dialog. 
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6.4 Go To USB2.0
The Go To USB2.0 feature takes you directly to an event in a Trace.

Step 1 Select Go To USB2.0 under Search on the Menu Bar to display the 
Go To USB2.0 drop-down menu. For 2.0 data, the menu is:

Step 2 Select the event you want to go to and enter the necessary information.
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Packet IDs (PIDs)

Select the type of packet to which you want to go.
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ANY Error
Repositions the trace to show the next instance of any error.

Errors
The Errors menu allows you to search for five different types of error: PID, CRC5, 
CRC16, Packet Length, and Stuff Bits. Menu items appear in bold if they are present in 
the trace or are grayed out if not present in the trace, as shown in the example below.

You can press Shift+E to go to the first error of any type. 
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Data Length
Allows you to search for data packets of particular lengths. Lengths are displayed in Bytes 
in a drop down menu as shown below. Selecting a length causes the display to move to 
the next instance of that packet length.

Addr & Endp
The Addr & Endp feature allows you to search for the next packet which contains a 
particular address and endpoint. All available address endpoint combinations are 
displayed in the pull down menu.
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Bus Conditions
Allows you to search by bus conditions such as traffic speed, reset, and suspend. All 
available bus conditions are displayed in the pull down menu.
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On-the-Go
Allows you to search for On-the-go attributes. The On-the-Go submenu contains entries 
for:

• HNP: Host Negotiation Protocol
• SRP: Session Request Protocol
• Host: A: Hosts with an A plug
• Host: B: Hosts with a B plug 

Channel
Allows you to search for traffic by 1 (Classic-Speed) or 0 (Hi-Speed).



USB Protocol Suite User Manual Chapter 6: Searching Traces

LeCroy Corporation  79

6.5 Go To USB3.0
The Go To USB3.0 feature takes you directly to an event in a Trace.

Step 1 Select Go To USB3.0 under Search on the Menu Bar to display the 
Go To USB3.0 drop-down menu. For 3.0 data, the menu is:

Step 2 Select the event you want to go to and enter the necessary information.

Packet Type

Select the Packet Type to which you want to go.

PHY Type

Select the PHY Type to which you want to go.
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Event

Select the Event to which you want to go.

Link Command

Select the Link Command to which you want to go.

LMP Subtype

Select the LMP Subtype to which you want to go.
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Transaction Packet Type

Select the Transaction Packet Type to which you want to go.
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6.6 Find
Find allows searches on an open trace using one or more criteria. You can search by 
packet, transactions, split transaction, transfer, packet type, and fields within packets.  

To run Find, select Search > Find or by click  on the toolbar. 

Searches can combine criteria using the options Intersection and Union.  
Intersection creates AND statements such as “Find all packets with x and y.”  
Union creates OR statements such as “Find all packets with x OR y.”

You can also perform searches in which packets or events are excluded from a trace, 
using the Exclusion option.

To perform a search: 

Step 1 Select Find... under Search on the Menu Bar

OR

Click  in the Tool Bar.

You see the User-Defined Find Events screen:
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Step 2 If the file has both USB 2.0 and USB 3.0 traffic, select either of these 
technologies in the Protocol area (upper right): USB 2.0 or USB 3.0.

Step 3 Select Packets, Transactions, Split Transactions, Transfers, HWA 
Segments, HWA Transfers, DWA Segments, DWA Transfers, 
PTP/MTP Transactions, PTP/MTP Objects, or PTP/MTP Sessions from the 
top left list box to list that type of event in the Events Group box.

Step 4 Select one or more events from the Events Group box:

• Address/Endpoint
• Address/RPipe
• Data Lengths
• Data Pattern
• Errors
• Handshake
• Link Command Types
• LMP Subtypes
• Object Counts
• Object Handler
• Object Format Type
• On-the-Go Protocol
• Operation Code
• Packet Types (Header, PHY, Event, Transaction)
• Result Status
• Split
• Transfer Lengths

Step 5 Select one of the following options:

• Union: Find all packets matching ANY of the specified events. 

• Intersection: Find packets matching ALL of the specified events. 

• Exclusion: Exclude packets matching any of the specified events.  
Exclusion works with the other two options:  
Select Union AND Exclusion (=Exclude packets with ANY of the following 
fields) or  
Intersection AND Exclusion (=Exclude packets with ALL of the following 
fields.) 
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Step 6 Optionally set the search Direction and Origin.

Step 7 Optionally check to Search in Hidden or Find All.
Step 8 Click OK.

After the search finishes, the program displays the packets meeting the search criteria.

Data Pattern Mask and Match
If you select Data Pattern as the Event Group in the Find dialog, you can set the Bitmask, 
Mask, and Match for each bit, 

Bitmask and Match always correlate. When you set Bitmask or Match. the other changes 
to maintain their correlation. 

Note: If you set Bitmask/Match before setting Mask, the Mask changes to the default 
mask. You must change to the Mask that you want. 

If you set an appropriate Mask before setting Bitmask/Match, the Mask does not change 
automatically to a default mask if you change Bitmask/Match.
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6.7 Find Next
To apply the previous Find parameters to the next search: 

• Select Find Next under Search on the Menu Bar.
OR

• Click  on the Tool Bar.

6.8 Search Direction
Toggles the search forward or backwards. The current direction is indicated in the menu.

6.9 Protocol
Select USB 2.0 or USB 3.0 for the technology to use for a mixed file.
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Chapter 7:  Display Options
You can select what information to display in Trace Views using the Display Options 
window.

To open the Display Options window: 

• Select Display Options under Setup on the Menu Bar.
OR

• Click  on the Tool Bar.:

You can select General, Color/Format/Hiding, and Level Hiding display options. The 
following sections describe these display options.
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7.1 General Display Options
You specify the main Trace View information types and settings using General Display 
Options (see figure on previous page): 

• Zoom Level: Zooms out from 100% (default) to 10% or zooms in from 100% 
to 200%.

• Enable Tips: Pops up text when you position the cursor over a field.
• Wrap: Wraps lines of traffic information instead of truncating lines at the right 

edge of the display.
• Hierarchy Lines: Displays lines on the left side of Trace View showing the 

hierarchy from Packets to Transactions to Split Transactions to Transfers if 
you show higher-level decodes.

• Timestamp Position: Aligns the Timestamp field At the beginning (in a 
column on the left side of the Trace View), At the end (in a column on the left 
side of the Trace View), or Merge with Packet/Transaction/Translation. 
Selecting this option allows easier comparison with previous or following 
timestamps.

• Expand Packet Data Fields by default: Displays packet data fields in 
expanded mode. If this option is not selected, packet data fields display in 
collapsed mode, and you can expand them manually.

• Expand Script-Based Decoded Info by default: Displays decoded transfer 
fields in expanded mode. If this option is not selected, decoded transfer fields 
display in collapsed mode, and you can expand them manually.

• Use new Std Reqs & Descriptors Scripts: Use dynamically loaded .DEC 
files (rather than .REQ and .DSC files) for decoding Class and Vendor 
requests or endpoints. 

• Show Protocol: Use USB 2.0 or USB 3.0.
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• Analysis Tools
• Error Report: Displays the Errors section of the Traffic Summary 

window. 
• Timing Calculator: Displays the Timing Calculator window from the 

beginning of a packet or marker to the beginning of another packet or 
marker, including Total Time unit, Bus Utilization Time and Bandwidth, 
and selected Global, Low Speed, Full Speed, High Speed, 
Transactions, and Devices. 

• Traffic Summary: Displays the Traffic Summary window, showing all 
reports, including Packets, Transactions, Transfers, and Errors. 

• Bus Utilization: Displays the Bus Utilization window, including Packet 
length, Bus usage, and Bus usage by device. 

• Link Tracker (3.0): Opens window that displays traffic in a strictly 
chronological view.

• Navigator: Displays the Navigation bar, including Pre/Post Triggers, 
Errors, and Types of Traffic. 

• Data View: Displays packet payload information.
• Real-Time Statistics (2.0): Displays the Real-Time Statistics window, 

including Data Packet Count, Data Payload Throughput, and 
Bus Usage. 

• Trace Viewing Level: Displays Packets, Transactions, Split Transactions, 
Transfers, Host Wire Adapter Segments, Host Wire Adapter Transfers, 
Device Wire Adapter Segments, Device Wire Adapter Transfers, 
PTP/MTP Transactions, PTP/MTP Objects, and PTP/MTP Sessions.

• Fonts: Sets the font type and bold or italic style for Fields and Data.
• Configuration Name: You can name the current set of Display Options 

values for use with an .opt file. (The options file can have a different name.)
• Restore Factory Presets: Sets all Display Options values to the installed 

values. 
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7.2 Color/Format/Hiding Display Options
To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab. 
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Color Display Options
The program uses a default set of colors for each type of data in each group of data. The 
colors and color combinations are appropriate for most graphic systems. You can alter 
any color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row 
(such as Data) in the Group and Color column and expand it. 

Select a data type (such as Data Length) in the Group, then select a color in the Color 
section, using Standard or Custom colors. Use a bright color for each important field. 
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To customize colors, use the Custom tab.

Note:  You cannot change the color of an Invalid Data (packet error) field. It is 
permanently set to red.

Formats Display Options
For each type of data in each group of data, the program has a default data format. 
Examples of number data formats are Bin (binary), Dec (decimal), and Hex 
(hexadecimal). Examples of date and time data formats are Hex uFrame, Dec uFrame, 
Date & Time, Time, Bit Time, seconds, microseconds, and nanoseconds. An example of 
a text data format is ASCII. You can alter some data formats.

To specify a data format for an information type, in the Color/Format/Hiding tab, select a 
row (such as Packet Fields) in the Group and Color column and expand it. 
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Select a data type (such as PID Types) in the Group: 

Select a format in the Format section. The following formats are available for PID Types: 

If available, select Bit Order in the Format section. The options are MSB to LSB or LSB 
to MSB.

Hiding Display Options
By default, no data is hidden. You can hide any group of data and any type of data. You 
can hide transactions, SOFs; NAKs; High, Full, or Low Speed packets; traffic from one or 
both recording channels; and Addresses and Endpoints.

To hide one or more fields, select the Group and Data type in the Group and Color 
column, then click the Hidden checkbox in the display or the Hidden checkbox in the 
Hidden section of the Format section. 
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7.3 USB 2.0 Hiding Options
By default, no data packets, transactions, or bus conditions are hidden. You can hide: 

• Start of Frame packets
• NAK’ed transactions
• Chirp Bus conditions
• SE0 Bus conditions
• High, Full, or Low Speed packets
• Channel 0 or Channel 1 packets

You can allow any toggle value after bus reset (Int and Bulk Endpoints). Depending on 
the device, after Bus Reset the endpoint toggle state might or might not be reset. 
Selecting this option prevents display of a toggle violation error.

You can have 2-stage SOF hiding. You can display all SOFs, hide all SOFs, or hide empty 
SOFs (show only SOFs with endpoint traffic and hide empty frames). Selecting this option 
allows you to hide empty SOFs with one click of the Hide SOF button or hide all SOFs 
with two clicks of the Hide SOF button.

Select the USB2 Hiding tab, then select the data types to hide.
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7.4 USB 3.0 Hiding Options
By default, no data packets, transactions, or bus conditions are hidden. You can hide: 

• Link Commands (Flow Control)
• Training Sequences (TS1, TS2, TSEQ)
• Logical Idle Packets
• Upstream Packets
• Downstream Packets
• Skip Sequences
• ISO Time Stamp Packets
• Inter-Packet Symbols (unexpected packets)
• Link Commands (Power Management)
• Electrical Idles
• LMP Packets
• LFPS Packets

Select the USB3 Hiding tab, then select the data types to hide
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7.5 Saving Display Options
You can save a set of Display Options values, make a set the default settings, or use a 
saved set of values with the commands at the bottom of the Display Options window: 

• To save the current Display Options values in an options file for use in future 
sessions, click Save. Enter a file name without a file name extension. The 
program adds the .opt extension. (The file must have an .opt file name 
extension.)

• To load a previously saved .opt file, click Load and select a file name.
• To save the current Display Options values in the default.opt options file for 

use as the default display options, click Save as Default. (Do not delete the 
default.opt file.)

• To apply the current Display Options values, click Apply. The Display Options 
window remains open.

• To apply the current Display Options values and close the Display Options 
window, click OK.

• To cancel unsaved changes to display values and exit the Display Options 
window, click Cancel. 
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Chapter 8:  Decode Requests
8.1 Class and Vendor Definition Files

LeCroy Analyzers use script files to decode class and vendor requests. The script files 
are read when the application is initialized. After reading, the Analyzer decodes class and 
vendor requests as instructed by the files.

.DEC files represent the new method of decoding. DEC stands for “decoder” and 
describes both Class and Vendor requests in a C-like language. Each .dec file stores an 
endpoint or request decode. When the application starts, these files are loaded 
dynamically. Subdirectories are supported. 

Note: The .dec files listed in the following table are in the Scripts directory under the 
installation directory: 

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID

Audio Class decoding 2.0
     AudioClass\Audio1.0Requests.dec
     AudioClass\Audio2.0Requests.dec

Audio 01h

Communications and CDC Control
Direct Line Control Model
Abstract Control Model
Telephone Control Model
Multi-Channel Control Model
CAPI Control Model
Ethernet Networking Control Model
ATM Networking Control Model
Wireless Handset Control Model
Device Management Model
Mobile Direct Line Model
OBEX Model
Communication Device Subclass/EEM
     Communications\CommRequests.dec
     Communications\CommInterrupt.dec
     Communications\CommCDCEEM.dec

CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID

02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h

01h
02h
03h
04h
05h
06h
07h
08h
09h
0Ah
0Bh
0Ch
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HID (Human Interface Device)
HUT (HID extension)
Monitor (HID extension)
Physical Interface  
     (force-feedback extension to HID)
Point of Sale Devices (HID extension)
Power (HID extension)
     Hid\hid.dec
     Hid\Hid_Req.dec

HID
HID
HID
HID 

HID
HID

03h
Extension
Extension
Extension 

Extension
Extension

  

Physical
     Hid\hid.dec
     Hid\Hid_Req.dec

HID 05h

Still Imaging Class
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

06h 01h 01h

Printer
     Printer\Printer_req.dec

Printer 07h 01h xxh

Mass Storage Mass Storage 08h

SCSI/Bulk Protocol
     MassStorageClass\MS_BulkOnly_Requests.dec
     MassStorageClass\MS_BulkOnlySCSIInEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec

Mass Storage
   SCSI Bulk

08h 06h 50h

UFI (floppy)/CBI Protocol
     MassStorageClass\MS_UFI_CBI_Requests.dec
     MassStorageClass\MS_UFI_CBI_BulkInEndp.dec
     MassStorageClass\MS_UFI_CBI_BulkOutEndp.dec
     MassStorageClass\MS_UFI_CBI_InterruptEndp.dec

MassStrg Class
   UFI CBI

08h 04h 00h

Hub support
     HubClass\HubClassRequests.dec
     HubClass\HubClassStatusEndpoint.dec

Hub Class 09h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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Picture Transfer Protocol (PTP)
[Photographic and Imaging Manufacturers
Association (PIMA) 15740 and ISO 15740]
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

Extension

Communications Device Class (CDC) Data
     Communications\CDCDataBulkIn_wCTE.dec
     Communications\CDCDataBulkIn_wPW.dec
     Communications\CDCDataBulkIn_wPW_wCTE.dec
     Communications\CDCDataBulkOut_wCTE.dec
     Communications\CDCDataBulkOut_wPW.dec
     Communications\CDCDataBulkOut_wPW_wCTE.dec
     Communications\CDCDataIsochIn_wCTE.dec
     Communications\CDCDataIsochIn_wPW.dec
     Communications\CDCDataIsochIn_wPW_wCTE.dec
     Communications\CDCDataIsochOut_wCTE.dec
     Communications\CDCDataIsochOut_wPW.dec
     Communications\CDCDataIsochOut_wPW_wCTE.dec

0Ah 00h

Smart Card (CCID)
     SmartCard\CCIDBulkIn.dec
     SmartCard\CCIDBulkOut.dec
     SmartCard\CCIDInterrupt.dec
     SmartCard\CCID_req.dec
     SmartCard\ICCDBulkIn.dec
     SmartCard\ICCDBulkOut.dec
     SmartCard\ICCDInterrupt.dec
     SmartCard\ICCD_req_Ver.A.dec
     SmartCard\ICCD_req_Ver.B.dec

CCID and ICCD 0Bh

Video Class (UVC) decoding 1.1 (currently at 1.0)
VIDEO CONTROL
VIDEO STREAMING
VIDEO INTERFACE COLLECTION
     VideoClass\VideoBulkIn.dec
     VideoClass\VideoBulkOut.dec
     VideoClass\VideoInterrupt.dec
     VideoClass\VideoIsochIn.dec
     VideoClass\VideoIsochOut.dec
     VideoClass\Video1.0Requests.dec
     VideoClass\Video1.1Requests.dec

Video
Video
Video

0Eh
0Eh
0Eh
0Eh

01h
02h
03h

00h
00h
00h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID



Chapter 8: Decode Requests USB Protocol Suite User Manual

100 LeCroy Corporation

Wireless Controller
BT
UWB
Remote Network Driver Interface Specification (RNDIS)
Host Wire Adapter
Device Wire Adapter
Device Wire Adapter Isochronous interface
     WireAdapter\WA_DataInEndpoint.dec
     WireAdapter\WA_DataOutEndpoint.dec
     WireAdapter\WA_NotifEndpoint.dec
     WireAdapter\WA_Requests.dec
     WireAdapter\WA_Radio_Requests.dec
     WireAdapter\WA_RadioNotifEndpoint.dec

HCI
WA Radio Control
Remote NDIS
Wire Adapter Class
Wire Adapter Class
Wire Adapter Class

E0h
E0h
E0h
E0h
E0h
E0h
E0h

01h
01h
01h
02h
02h
02h

01h
02h
03h
01h
02h
03h

Miscellaneous Device Class
Interface Association Descriptor 
 

Wire Adapter Multifunction 
     Peripheral programming interface
Cable Based Association Framework (CBAF) Requests 

     Standard\StandardRequests.dec
     IEEE\IEEECompanies.dec
     Virtual\VirtualDATAIn.dec
     Virtual\VirtualDATAOut.dec
     Virtual\VirtualUARTIn.dec
     Virtual\VirtualUARTOut.dec
     AssociationFrameworks\  
          WUSB_CableBasedAssociation.dec

IrDA Bridge
ATAPI
IP
HTTP
Personal Healthcare Devices
   PersonalHealthcare\PersonalHealthcareRequest.dec
   PersonalHealthcare\PersonalHealthcareDescriptors.inc
   PersonalHealthcare\PersonalHealthcareDataBulkIn.dec
   PersonalHealthcare\PersonalHealthcareDataBulkOut.dec
   PersonalHealthcare\PersonalHealthcareDataBulk.inc
Content Security Devices
   ContentSecurity\ContentSecurityRequest.dec
   ContentSecurity\ContentSecurityDescriptors.inc
   ContentSecurity\ContentSecurityInterrupt.dec

Standard,  
   so no decoder 
   method needed
Wire Adapter Class 

Association 
   Frameworks

 

IrDA Bridge
ATAPI
IP
HTTP
Personal 
Healthcare

Content Security

EFh
EFh 
 

EFh 

EFh 

 

FEh
08h

0Fh

0Dh

02h 
 

02h 

03h 

 

02h
02h

01h 
 

02h 

01h 

 

00h
50h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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You can create your own .dec file for a Class or Vendor Request. For more information 
on the format of these Script Decoder files and the Script Decoding language, read the 
Script Decoder Manual.

8.2 Class/Vendor Decoding Options
You can permanently assign a class or vendor decoding for an address and/or endpoint 
or interface in a trace file. Once assigned, the decoding occurs automatically when you 
display transactions.

Mapping Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Right-click the Control Transfer field to display the USB Device Request menu:

Step 2 Select Map Request Recipients to Class/Vendor Decoding to display the 
Request Recipient and Endpoints dialog box: 

The Recipient field shows all Class and Vendor Request Recipients found in the 
trace file. The display shows the Host, Address, and Type (Class or Vendor) for 
the recipient. On the right are the names of Class/Vendor Decoding groups 
currently assigned to recipients. If blank, no decoding is assigned for a recipient. 

Step 3 Select a recipient.
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Step 4 Display the Class/Vendor Decoding Groups drop-down menu.

The drop-down menu lists the defined Class/Vendor request decoding groups. 
The Class/Vendor Decoding Groups are:

• No Decoding
• Audio 1.0 Class Requests
• Audio 2.0 Class Requests
• Audio Class Requests
• CCID Requests
• Communication Class Requests
• HCI Command
• HID Class
• HID Class Requests
• Hub Class Requests
• ICCD Ver. A Requests
• ICCD Ver. B Requests
• IrDA Bridge Class Requests
• Mass-Strg Bulk-Only Requests
• Mass-Strg Class UFI CBI Requests
• Printer Class Requests
• RNDIS Communication Class Requests
• Standard Requests
• Still Image/PTP/MTP/PictBridge Class Requests
• Video 1.0 Class Requests
• Video 1.1 Class Requests
• Video Class Requests
• Wire Adapter Radio Control Request
• Wire Adapter Class Requests
• WUSB CBAF Requests
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Step 5 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 8 Click OK.
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Mapping Endpoint to Class/Vendor Decoding
To assign a Class/Vendor Endpoint decoding, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Right-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoints tab to display the Endpoints dialog box. 

The Endpoint field (Endp) shows all Endpoints found in the trace file. The 
displays shows the Host, Address, and Direction for the recipient. On the right 
are the names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient. 

Step 4 Select an endpoint.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu: 

The Class/Vendor Endpoint Decoding options for an OUT endpoint are: 
• No Decoding
• ATAPI MMC4 Out Endp
• ATAPI SPC3 Out Endp
• ATAPI SSC2 Out Endp
• CCID Bulk Out Message
• CCD Data Bulk Out w/ Cmd Wrapper
• CCD Data Bulk Out w/ Prot & Cmd Wrapper
• CCD Data Bulk Out w/ Prot Wrapper
• CCD Data Isoch Out w/ Cmd Wrapper
• CCD Data Isoch Out w/ Prot & Cmd Wrapper
• CCD Data Isoch Out w/ Prot Wrapper
• Display DATA
• HCI data out
• HCI SCO out
• HTTP Out Endp
• ICCD Bulk Out Message
• IP_ET0800 (Internet Protocol) Out Endp
• IPv6_ET0800 (Internet Protocol) Out Endp
• IrDA Bridge Out Endp
• Mass Strg Bulk-Only SCSI Out Endp
• Mass Strg UFI_CBI Bulk Out Endp
• RNDIS_PACKET_MSG Bulk Out
• Still Image/PTP/MTP/PictBridge Bulk Out
• TCP (Transmission Control Protocol) Out Endp
• Video Bulk Out
• Video Isoch Out
• Virtual UART
• Wire Adapter Data Transfer Out Endp
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The Class/Vendor Endpoint Decoding options an IN or Interrupt endpoint are: 

• No Decoding
• ATAPI MMC4 In Endp
• ATAPI SPC3 In Endp
• ATAPI SSC2 In Endp
• CCID Bulk In Message
• CCD Data Bulk In w/ Cmd Wrapper
• CCD Data Bulk In w/ Prot & Cmd Wrapper
• CCD Data Bulk In w/ Prot Wrapper
• CCD Data Isoch In w/ Cmd Wrapper
• CCD Data Isoch In w/ Prot & Cmd Wrapper
• CCD Data Isoch In w/ Prot Wrapper
• Communication Class Interrupt Notification
• Display DATA
• HCI data in
• HCI event
• HCI SCO in
• HID In Endp
• HTTP In Endp
• Hub Class Status Change Endp
• ICCD Bulk In Message
• ICCD Interrupt Message
• IP_ET0800 (Internet Protocol) In Endp
• IPv6_ET0800 (Internet Protocol) In Endp
• IrDA Bridge In Endp
• Mass Strg Bulk-Only SCSI In Endp
• Mass Strg CBI Interrupt Endp
• Mass Strg UFI_CBI Bulk In Endp
• Mass Strg UFI_CBI Interrupt Endp
• RNDIS_PACKET_MSG Data In
• Still Image/PTP/MTP/PictBridge Bulk In
• Still Image/PTP/MTP/PictBridge Interrupt
• TCP (Transmission Control Protocol) In Endp
• Video Bulk In
• Video Interrupt
• Video Isoch In
• Virtual UART
• Wire Adapter Radio Notif Endp
• Wire Adapter Data Transfer In Endp
• Wire Adapter Notif Endp



USB Protocol Suite User Manual Chapter 8: Decode Requests

LeCroy Corporation  107

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional endpoints you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request RPipe to Class/Vendor Decoding
Before mapping Request RPipes to Class/Vendor Decoding, you must first assign the 
following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Right-click the Control Transfer field to display the USB Device Request menu.

Step 2 Select Map RPipe to Class/Vendor Decoding to display the Request Recipient 
and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog box: 

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Otg Host, HWA address, and Type (Class 
or Vendor) for the recipient. On the right are the names of Class/Vendor 
Decoding groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Endpoint RPipe to Class/Vendor Decoding
To assign a Class/Vendor Endpoint RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Right-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box: 

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Direction for the recipient. On the right are the 
names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request DWA RPipe to Class/Vendor Decoding
Before mapping Request DWA RPipes to Class/Vendor Decoding, you must first assign 
the following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Right-click the Control Transfer field to display the USB Device Request menu. 

Step 2 Select Map DWA RPipe to Class/Vendor Decoding to display the Request 
Recipient and Endpoints dialog box.

Step 3 Click the Request DWA RPipes tab to display the Request DWA RPipes dialog 
box: 

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Otg Host, HWA address, and Type (Class 
or Vendor) for the recipient. On the right are the names of Class/Vendor 
Decoding groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.
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Step 9 Click OK.

Mapping Endpoint DWA RPipes to Class/Vendor Decoding
To assign a Class/Vendor Endpoint DWA RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Right-click the Bulk/Int Transfer field to display the 
USB/WUSB Device Request menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box: 

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Direction for the recipient. On the right are the 
names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint DWA RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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8.3 General Options
Commands are transferred on USB using special control transfers called USB Device 
Requests. The Analyzer can decode Device Requests as they are defined in the USB 
specifications and various Device Class and Vendor specifications.

Each USB Device Request is sent using a Control Transfer. Each Control Transfer starts 
with a SETUP transaction.

Decoding USB Device Requests
To decode a USB Device Request: 

Step 1 Right-click the Control Transfer field or the SETUP field of the 
USB Device Request to display the USB Device Request menu: 

Note:The menus shown in this section are context-sensitive. You may see 
slightly different menus. 

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use this option 
to reanalyze all transactions. 

Step 3 To use the previous decoding, click Load most recent decoding mapping. 

This option loads the most recent mapping of endpoints/requests to decoding 
types that was done on a previous trace. If the endpoints of the new trace are the 
same as the last one mapped, the mappings are applied to the current trace. This 
saves the user from having to constantly apply the mapping to a new trace every 
time the application is restarted and a new trace created. 

The ability to retain the mapping from trace to trace DURING an application 
session already exists: the Keep Across Recordings button in the endpoint map 
dialog. This new feature simplifies the process when the application has been 
re-started. 

Note:You can also change the format, color, and hidden status of fields, using 
the same methods as in Display Options. (See Chapter 6, Display 
Options.)
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Decoding Standard Requests
To decode a standard request: 

Step 1 From the USB Device Request menu, select Decode Standard Request to 
display the View Fields for Standard Request text box: 

Step 2 To find a word in the text box, click the Find button. Enter the word in the Find 
What field. To use a case-sensitive search, check Match Case. To find only the 
exact word, check Match Whole Word Only. You can search Up or Down. To 
search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As button, enter 
a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the same request 
type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions and values of 
the Standard Request. 
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For field definitions, please refer to the Universal Serial Bus Specification, version 2.0. 
The USB specification is available from the USB Implementers Forum (USB-IF) at: 

Decoding Class Requests
Examples of a class request are Mass-Strg Class UFI CBI Requests, 
PTP Still Image Class Requests, Video Class Requests, and Wire Adapter Class 
Requests. 

To decode a class request: 

Step 1 From the USB Device Request menu, select Decode ... Request to display the 
View Fields for ... Class Requests text box.

The following figure shows a Wire Adapter Class Requests decoding:

Decoding Vendor Requests
To decode a vendor request: 

• From the USB Device Request menu, select Decode ... Request to display 
the View Fields for ... Vendor Requests text box.

An example of a vendor request is Command Set. 

Decoding Undefined USB/WUSB Device Requests
A Decoding Request may not belong to any of the defined decoding groups (Standard, 
Class, or Vendor).

USB Implementers Forum 
1730 SW Skyline Blvd.  
Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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Decoding using Endpoint Information
To decode using the endpoint information: 

Step 1 Right-click the Bulk/Int Transfer field to display the Bulk/Int Transfer (IN/OUT 
transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text box.

The following figure shows a Wire Adapter Data Transfer Out Endp decoding: 

Changing the Layout of Decode Requests
In the View ... Fields windows, the Decoding Information and the Descriptor information 
blocks (following the Request Summary information) have the following columns:

• Field: such as bRequest, wValue, wIndex, bLength, bDescriptorType, 
wTotalLength

• Length in bits
• Offset in bits
• Decoded: hex value typically equal to Hex Value
• Hex Value: hex value typically equal to Decoded
• Description: short description of field
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To change the layout of decode requests display: 

Step 1 Click Layout to display the View ... Fields Dialog Layout dialog box: 

Step 2 To display the available columns of data, use the checkboxes for Length, Offset, 
Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields specified 
for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check Use these 
settings when View Fields dialog opens.
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Chapter 9:  Reports
The Report menu provides several reports to assist you in analyzing USB traffic recorded 
by the Analyzer.

Reports assist you in analyzing traffic recorded by the Analyzer. The available reports 
are: 

• File Information: To view general information about the trace file.
• Error Summary: To view a count of errors in a trace file.
• Timing Calculations: To view timing measured between two events set within the 

trace file.
• Traffic Summary: To view a summary of protocol-related information in the trace 

file summary information about a selected group of items in the trace file (such as a 
count of particular frame or packet types).

• Bus Utilization: To display information on bandwidth usage for the transmit and 
receive channels.

• Link Tracker (3.0): Displays a detailed chronological view of events.
• Spec View (3.0): Shows packet header information and other items, in a view that 

matches the USB 3.0 specification.
• Packet Data: Shows packet payload contents.
• Trace Navigator: Navigates within the trace to view the location of errors and 

triggers, narrow the range of traffic on display, and jump to any point in the trace.
• Real Time Statistics: To display statistical information for the channels.
Reports are available from the Report menu and buttons on the Tool bar. Tools are 
available from the Tools menu. 
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9.1 File Information
To display a File Information report, select File Information under Report in the 
 
Menu Bar, or click  in the Tool Bar to display the File Information screen: 
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The File Information report provides information about how the recording was made, 
what the buffer settings were, what the trigger options were, and what version of all the 
Analyzer hardware was used to make the recording.

9.2 Error Summary
The Error Summary details all errors analyzed throughout the recording.

• Select Error Summary under Report in the Menu Bar
OR

• Click  in the Tool Bar to display the Error screen below the Trace View:
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9.3 Timing Calculations
The Timing Calculator is used to measure timing between any two packets.

• Select Timing Calculations under Report in the Menu Bar
OR

• Click  in the Tool Bar to display the Timing and Bus Usage Calculator 
screen: 
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9.4 Traffic Summary
Traffic Summary summarizes the numbers and types of packets, transactions etc. that 
occurred in the open trace.

To run Traffic Summary, select Report >Traffic Summary or 

click the button marked . The program prompts you to specify a range of packets, 
then displays the following window: 

The Options menu allows you to show Grid lines, Row selection, and Tight 
columns. You can have Event Navigation: Skip hidden items, Show hidden 
items, and Prompt for hidden.
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9.5 Bus Utilization
The Bus Utilization window displays information on bandwidth use for the three 
recording channels. 

To open the Bus Utilization window, select Report >Bus Utilization  
 
or click the button marked . 

A window opens with graph areas. For USB 2.0, the display is similar to the following:
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For USB 3.0, the display is similar to the following:
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed 
data and for exporting data:

The buttons have the following functions: 

Save As - Saves the graphs as a 
bitmap file (*.bmp) Vertical zoom in

Email - Creates an email with a 
*.bmp file attachment of the graphs Vertical zoom out

Print
Click and Drag zoom - Click 
diagonally to select and zoom in on 
part of the graph

Full Screen Select Range.

View Settings - opens a sub-menu 
with options for formatting the 
display. See “View Settings Menu” 
below.

Sync and Graph areas - If two or 
more graphs are displayed, this 
button synchronizes the graphs to 
one another. Once synchronized, the 
positioning slider of one graph 
moves the other graphs.

Horizontal zoom in
Graph Areas - Presents options for 
displaying additional graphs of data 
lengths, packet lengths, and 
percentage of bus utilized.

Horizontal zoom out
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View Settings Menu

Clicking the View Settings button  causes a menu to open with options for formatting 
the display.

• Orient Horizontally: changes the orientation of bus usage to horizontal. After 
selecting this option, the menu has Orient Vertically.

• Tile Vertically: tiles the two graphs vertically (i.e., side by side). After 
selecting this option, the menu has Tile Horizontally.

• Show Markers: Places "tick" marks along the x axis of each graph.
• Show Plumb Line
• Status: Opens a sub-menu with the following options:

• Bar: Displays a status bar at bottom of graph.
• Tooltip: Causes a tooltip to appear if you position your mouse pointer 

over part of the graph and leave it there for a couple of seconds.
• None: Turns off tooltips and the status bar.

• Grid Lines: Opens a sub-menu with the following options:
• Both: Displays both X and Y axis gridlines
• X Axis: Displays X axis gridlines
• Y Axis: Display Y axis gridlines
• None: Turns off gridlines

• Grid on Top: Moves the grid lines above the graph.
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• Fonts and Colors: Opens a dialog box for setting the colors and fonts used in 
the graphs:
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Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus Utilization 
window. 

To view information: 

Step 1 Click the  button to open the Graph Areas menu. For USB 2.0. the display 
is similar to the following: 

For USB 3.0. the display is similar to the following: 

Step 2 Select the data you want to appear in the Graph Areas window.

Step 3 To make a new graph, click New.
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To change the properties in the Bus Utilizations graph: 

Step 1 In the Graph Area properties dialog box, select what you want your graph to 
display, then click OK.

Step 2 To make a new graph, click New.
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9.6 Real Time Monitoring
The Real-Time Statistics window displays a graph of real-time link activity.

Real Time Statistics displays a summary of the traffic currently being recorded by the 
Analyzer. 

To display the Real-Time Statistics window, click  in the Tool Bar to open the Real 
Time Statistics window.

For USB 2.0, the display is similar to the following: 
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For USB 3.0, the Real-Time Statistics window can display a SuperSpeed graph of 
real-time link activity. 

In order to see a graph of traffic, you must start recording.  

Press  to start the Real-Time statistics monitor. As traffic is recorded, data is 
streamed in real time to this window and presented in a format of your choice.  

To stop the monitor, press . 
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Real-Time Statistics Buttons
The Real-Time Statistics toolbar has buttons for changing the format of the displayed 
data and for exporting data:

The buttons have the following functions:

Save As - Saves Real-Time graphs 
as bitmap files (*.bmp) Vertical zoom in

Email - Creates an email with a 
*.bmp file attachment of the graphs Vertical zoom out

Print
Click and Drag zoom - Click 
diagonally to select and zoom in on 
part of the graph

Full Screen

View Settings - opens a sub-menu 
with options for formatting the 
display. See “View Settings Menu” 
below.

Sync and Graph areas - If two or 
more graphs are displayed, this 
button synchronizes the graphs to 
one another. Once synchronized, the 
positioning slider of one graph 
moves the other graphs.

Horizontal zoom in
Graph Areas - Presents options for 
displaying additional graphs of data 
lengths, packet lengths, and 
percentage of bus utilized.

Horizontal zoom out
Start. Starts the Real-Time Monitor.

Stop Real-Time Monitoring.

Reset graphs.
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Real-Time Statistical Monitor Pop-up Menu
If you right-click a graph in the Real-Time window, a pop-up menu appears with options 
for changing the format of the display: 

• Undo Zoom: If you have zoomed in, undoes the zoom.
• Fit to Graph Area: Displays graph so that the entire trace fits inside the graph 

area.
• Y Scale Type: 
• Linear: Converts display to linear format.
• Logarithmic: Converts display to logarithmic format.
• Hide: Hides the selected graph.
• Properties: Opens a dialog box with options for changing the colors, titles 

and other features of the graphs.
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Displaying Multiple Graphs
The Real Time Statistics window gives you the ability to create up to three separate 
graphing windows so that you can create separate graphs of traffic and tile them 
vertically. Within these windows, you can format the graphs in a number of ways.

• To view two or three graphs simultaneously,  

click the Graph Areas  button. 

The following menu opens.

Selecting a checkbox displays the selected graph type: 

• Statistics Accumulation: Plots the percentage of Link utilization by non-idle 
traffic for both directions of the link.

• Data Packet Count (Packets/s): Plots counts of Data Packets per second for 
both directions of the link.

• Data Payload Throughput (MBytes): Plots data payload throughput for both 
directions of the link.

• Bus Usage: Plots amount of Bus usage. 
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9.7 Link Tracker (3.0)
The Link Tracker window displays a detailed chronological view of events. Events are 
shown on a channel-by-channel basis in columns within the window. 

You can select the number of columns to view more or less data at one time.

Each time slot in the vertical axis represents the minimum time that a DWORD requires 
to traverse the bus. 

Toolbar: Presents buttons for changing the format of the Link Tracker window.

Main Display Area: Displays traffic chronologically as it occurred in the recording. The 
window divides into columns: the first column shows time and traffic is shown on a 
channel-by-channel basis in the columns on the right.

Using the Link Tracker Window
The Link Tracker window can be reformatted in several ways.
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Zooming In and Out
Zooming out can give you a quick, high-level view of a trace. A fully zoomed out trace 
only shows columns and colored lines. Using the colors, you can see what types of traffic 
run through the trace. 

Further information can be obtained on any point of interest in the trace by positioning 
your mouse pointer over it. Tool tips provide detailed description of events. 

Note: When fully zoomed out, the smallest graphical unit is the DWORD, represented by 
a single line. Zooming out makes the trace appear smaller and increases the time scale 
in the first column.
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Collapsing Idle Time, Enabling Tool tips, and Resetting Column 
Widths
Click the View Options button  to open a menu with options for formatting the 
display. Three options are presented:

Collapsible Idle Time: Opens a dialog box for setting the Idle time value. Setting a value 
tells the Analyzer when to collapse Idle times and display them as grayed out strips within 
the Bus View window. 

Tooltip Display: Opens a menu with options for adding content to Tooltips. Tooltips 
display when you position the mouse pointer over an item in the Bus View window. The 
options are:

• Tooltips Display Values
• Tooltips Display Scrambled Values
• Tooltips Display 10-bit Codes
• Tooltips Display Symbols

Time Format: Seconds or Clock

Reset Column Widths: This option resets column widths to their defaults and enables 
columns to resize themselves automatically any time the application window is resized. 
Normally, columns automatically resize themselves if the application window is made 
larger or smaller. However, if you manually resize any columns in the Bus View window, 
column widths become static. Thereafter, if you resize the application window, the 
Bus View columns do not adjust automatically. Reset Column Widths re-enables the 
automatic resizing capability.

Reset Columns Order: Return to default column sequence.

Docking and Undocking the Window
You can undock the Link Tracker window by double-clicking the blue title bar along the 
left side of the window. Once undocked, the window can be dragged anywhere in the 
application. To redock, double-click again on the title bar.

Setting Markers
Markers can be set on any event within the Link Tracker window. 

To set a marker, right-click an event, then select Set Marker from the pop-up menu. 

Once marked, you can navigate to events with the Go to Marker command in the Search 
menu. 

Markers set in the Link Tracker window display the packet number and DWORD number. 
In contrast, markers set in the Trace window just show the packet number. 

Hiding Traffic
You can hide Idles and other data from the Link Tracker window by clicking the Hide 
buttons on the toolbar.
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Link Tracker Buttons
The Link Tracker window has a row of buttons for changing the format of the displayed 
data and for exporting data: The buttons have the following functions:

Full Screen. Expands the Link Tracker window to fill the entire screen.

View Options. Opens a menu with three options: 
• Collapsible Idle Time (Collapse Idle Bigger Than n nanoseconds.  

Note: Does not affect Collapse Idle Plus.)
• Tooltip Display (Values, Scrambled Values, 10-bit Codes, Symbols)
• Time Format (Seconds, Clock)
• Reset Columns Widths (return to default widths)
• Reset Columns Order (return to default column sequence)
See “Using the Link Tracker Window” on page 134 for further details.

Synchronize Trace View. Synchronizes the Trace View and Link Tracker 
windows so that a move in one window repositions the other.
Because of the differences in scale and logic between the Link Tracker 
and Trace view window, scrolling produces different effects depending on 
which window is being scrolled. 
Scrolling in the trace window causes the Link Tracker window to rapidly 
jump from event to event. Long periods of idle time are thus skipped. 
Scrolling in the Link Tracker window, in contrast, produces modest 
movements within the trace window. 
Scrolling in the Link Tracker window causes the trace window to pause 
until the beginning of a packet is displayed. At that point, the trace window 
repositions itself. While scrolling long Idle periods or through the contents 
of a packet, the trace window does not move.

 
Zoom In

Zoom Out

Continuous Time Scale. No collapsing.

Collapse Idle. Do not show some periods of Link being idle.

Collapse Idle Plus. Do not show periods of Link being idle.
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Show Values

Show Scrambled Values

Show 10b Codes

Show Symbols

Show Text

                 Columns to view
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9.8 Spec View (3.0)
The Spec View shows packet header information.

To obtain the Spec View, select Report > Spec View  

or click the  Spec View toolbar icon. 

The toolbar allows you to Save, go to Previous or Next, display Hexadecimal or Binary, 
and Update only on request, Update on click, or Update on scroll. 
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9.9 Data View
The Data View window shows packet information.

To obtain the Data View window, select Report > Data View  

or click the  toolbar icon. 

The Data View toolbar buttons allow you to:

• Save
• Go to Previous or Next
• Display Hexadecimal, ASCII, Decimal, or Binary
• Use MSB Format or LSB Format
• Use Big Endian or Little Endian 

The Format field allows you to enter the number of BYTEs, WORDs, or DWORDs per 
line.
The Columns field allows you to set the number of columns.
You can Update only on request, Update on click, or Update on scroll.
You can enter an offset in the Scroll to Offset field and click the arrow to scroll there.

You can enter text in the Search field and click Search Previous or Search Next to go 
there.
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9.10 Using the Trace Navigator
The trace Navigator is a tool for navigating within the trace. It allows you to view the 
location of errors and triggers in a trace and to narrow the range of traffic on display. It 
also allows you to quickly jump to any point in the trace.

Displaying the Navigator

Click  in the toolbar to display the Navigator. 

The Navigator appears on the right side of the Main window. It has a two-button toolbar 
and a vertical slider bar. It also has colored panes for navigating the trace in different 
ways. You set which panes are displayed through Navigator pop-up menus.
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Navigator Toolbar
The Navigator toolbar lets you quickly set Navigator features. The toolbar has two 
buttons.

Navigator Ranges: This button brings up a pop-up menu that lets you reset the 
Navigator range. The range determines what packets are viewable in the trace display.

Navigator Panes: This button has two purposes: To select which Navigator panes 
appear and to bring up the Navigator legend. The legend determines how information is 
shown in the panes.

Navigator Ranges
You set the viewing range by dragging the yellow range delimiters along the slider. 

To set the lowest packet viewable, drag the top delimiter up. As you do so, a tool tip 
appears to indicate the current range. Stop dragging when you reach the desired lowest 
packet. 

To set the highest packet viewable, drag the bottom delimiter down. Stop when the tool 
tip indicates you are at the desired highest packet.

To Determine Current Position
In addition to the two range delimiters, the slider has a blue current-position indicator 
(see above). The current-position indicator shows where you are in the trace display with 
respect to the possible viewing range. 

For example, suppose you set viewing range to packet 0 through packet 500 (the top 
range delimiter is at packet 0, and the bottom range delimiter is at packet 500). If you then 
move the current-position indicator on the slider to midway between the top and bottom 
delimiters, then packet 250 appears in the middle of the trace display. 
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To Reset Navigator Range
You can reset the Navigator range using the toolbar Navigator Range button. Press the 
button to bring up the Navigator Range drop-down menu. 

The menu has the following options:

• Set Range to Whole Trace: Allows you to reset the range to include the entire trace 
file contents. The top range delimiter is placed at the lowest packet number in the 
trace. The bottom range delimiter is placed at the highest packet number in the 
trace.

• Set Range Near Packet xxx: Allows you to collapse the range so that only the 
packets immediately above and below the xxx packet are displayed. The xxx packet 
is whatever packet is currently at the top in the trace display.

• Recently Used Ranges: Allows you to reset the range to any of a number of 
recently used (previously set) ranges. 
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Navigator Panes
You can display any combination of trace Navigator panes. 

From left to right, the panes are: Pre/Post Trigger, Errors, Traffic Types, and Protocols of 
Traffic. Each pane represents the entire trace with respect to different types of 
information. The top of each pane represents the start of the trace file, and the bottom 
represents the end of the trace file.

• Pre/Post Trigger: To view the trigger event in the trace and the relative size of 
pre-trigger and post-trigger portions of the trace. The two portions are set apart as 
different colors. The trigger event occurs at the point the two colors meet.

• Errors: To view any errors in the trace. A thin red line represents each error in the 
pane.

• Traffic Types: To view the types of packets that occur in the trace. A different color 
represents each packet type in the pane. The relative size of colored portions in the 
pane corresponds to the amounts of the various packet types in the trace. As 
described below, you can use the Navigator legend to change the types of packets 
that take precedence in the display.

• Protocols of Traffic: To view USB 2.0, USB 3.0 Host Tx, or USB 3.0 Host Rx.

To Show/Hide Navigator Panes
You can show/hide any of the panes using pop-up menus accessible through right-click 
the Navigator Panes button or by right-click anywhere in any Trace Navigator pane.
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Navigator Slider
The Navigator slider appears at the left of Navigator panes. The slider has yellow upper 
and lower range delimiters and a blue current-position indicator.

The Navigator slider lets you to set the range of packets viewable in the trace display. In 
other words, it sets scrolling range of the display. You can scroll the display up to the 
lowest packet number in the viewing range. You can scroll the display down to the highest 
packet number in the viewing range.

Trace Navigator Legend
The Navigator legend lets you control the display of content in Navigator panes.

You bring up the legend through the Navigator Panes drop-down menu. Press the toolbar 
Navigator Panes button to access the menu. Select the Legend option to bring up the 
Navigator Legend dialog box.

The Navigator Legend dialog box has areas corresponding to each of the panes. Each 
area has check boxes that allow you to hide/display information in the pane. You can set 
the priority of information displayed in the panes using the up and down triangles on the 
right.

Using the Legend to Show/Hide Navigator Panes
To use the legend to show/hide an entire pane, use the checkbox next to the name of 
each pane in the legend. 

In the case of the Pre/Post Trigger and Errors areas, the action of show/hide in the legend 
is identical to that provided by Trace Navigator pop-up menus. 

In the case of the Traffic Types pane, there is no equivalent show/hide available through 
the pop-up menus.
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Using the Legend to Set the Priority of Information Display
You can use the legend to set the priority of information displayed in the Pre/Post Trigger 
Traffic Type panes. This is a two-step process. 

Step 1 For a particular item in a pane, click the column next to the checkbox 
for the item. That labels the item as currently active. 

Step 2 Next, use the up-down at the lower-right of the area to move the item 
higher or lower in priority.

In the case of the Traffic Type pane, priority determines display priority of each packet 
type. For portions of the trace that are dominated by a particular packet type, this setting 
no effect: only the color corresponding to that packet type is displayed in that portion of 
the pane. Suppose, however, that part of the trace includes equal or near equal numbers 
of several types of packets. In that case, you can use the legend to select which among 
those types is represented in that portion of the Traffic Types pane. This allows you to 
view only packets of interest in crowded portions of the trace display.
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Chapter 10:  Recording Options
Use Recording Options to create and change various features that control the way 
information is recorded by the Analyzer. 

To open the Recording Options dialog box: 

• Select Recording Options under Setup on the Menu Bar.
OR

• Click  on the Tool Bar.
You see the Recording Options dialog box: 

The Recording Options window always opens with the General tab showing. 
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10.1 General Recording Options
The General Recording Options allow you to select or adjust the recording type, the 
buffer size, the amount of post-trigger recording, and the trace filename and path.

Recording Type
The Recording Type box presents three options that allow you to set how the Analyzer 
begins and ends a recording. 

The options are: Snapshot, Manual Trigger, and Event Trigger.

Snapshot
A Snapshot is a fixed-length recording. The size of this recording is set by

the Buffer Size box. Recording begins when  is clicked and ends

when either the selected buffer size is filled or the  button is pressed. 

Manual Trigger
A Manual Trigger is a recording whose trigger point is caused by pressing the trigger 
button on the front panel.

Recording begins when you click  on the Tool Bar. Recording continues in a circular 
manner within the limits set by the buffer size.

Recording ends when  is clicked on the Tool Bar or after post-trigger memory has 
been filled following depression of the trigger button on the front panel.

Event Trigger
Recording begins when you click  on the Tool Bar.

Recording continues in a circular manner within the limits set by the buffer size until an 
event is detected that meets the Trigger conditions specified in the Triggering Options 
and the defined amount of data has been recorded after the Trigger Event.
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Options
• Truncate Data Fields (2.0): Allows data fields to be truncated during 

recording in order to save Analyzer memory and allow recording of more 
packets. Enter a minimum data length value in the Bytes box. The system 
truncates the data to the stated value or slightly larger.

Note:  Truncation of data may cause incorrect transaction or transfer decoding. 

• Beep When Trigger Occurs: The computer connected to the Analyzer beeps 
three times when a Trigger condition is first detected.

Recording Channels
You can choose USB 2.0 or USB 3.0 as the recording channel.

Buffer Size
You can adjust the size of the recording buffer from 3.2 megabytes to 1 or 4 gigabytes. 

The Recording type option determines how this buffer is used. Although there are 1 or 
4 gigabytes of physical memory in the Analyzer, the efficiency of the recording is about a 
2:1 ratio of physical memory to actual USB traffic. Shorter USB packets yield a slightly 
less efficient recording. The non-traffic portion of physical memory is utilized for control 
and timing information.

Note:  The scale is not linear and affords more granularity in the smaller buffer 
sizes. 
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Trigger Position
You can adjust the amount of recording to be done post-Trigger or select where you want 
the Trigger located within the defined buffer. You can adjust the Triggering Position 
between 1 and 99% post-Trigger. Trigger Position is available only when Manual 
Trigger or Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position 
settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note:  When a Trigger occurs, recording continues until the post-Trigger amount of 
the buffer is filled or when Stop is selected.

Options Name
The Options Name is a descriptive label of the current Recording Options settings. 
Options Names are associated with files that have a .rec suffix. 

The default option name is default. Default preserves the current Recording Options 
settings.

The purpose of the Options Name box is to give you a place to preserve different 
Recording Options that you use on a recurrent basis. For example, if you use two or three 
different Recording Options configurations, you can save these configurations and load 
them the next time they are needed.

Because Options Names are descriptive labels and not file names, you can enter in any 
text you like into the box. Your labels can be very descriptive such as "Trigger on High 
Speed traffic when CRC errors occur." 

To create a new Recording Options name: 

Step 1 Enter a comment for the new file in the Options Name field.

Step 2 Click Save to display the Save As window.

Step 3 Specify a filename (*.rec)

Step 4 Click Save.

To load a Recording Options name:

Step 1 Click Load to display the Open window.

Step 2 From the list of .rec files, select the one that represents your Options Name.

The options settings for that name then display.
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Trace File Name & Path
Trace File Name & Path opens a Save As dialog box for saving your trace file. The 
default recording file name is data.usb for Low, Full, and High Speed recordings. If you 
are recording on both channels, then the system creates two files: data_0.usb for 
Channel 0, and data_1.usb for Channel 1.

• Click Trace File Name & Path.
You see a Save As… window in which to enter the recording file name *.usb for all 
subsequent recordings.
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10.2 Recording Options - Misc. USB 2.0
The Misc. USB 2.0 page presents options for setting:

• Analyzer Trace Speed: Select Auto-Detect, Low, Full, or High.
• USB On-the-Go: Check On-the-Go SRP. Optionally select 

Dual Role Devices as 2 DRD’s and enter device names. Optionally assume 
that B is the first host.

• Generator/Analyzer Clocking Overrides: Select Slow Clock and enter 
number of megahertz. 
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Analyzer Speed
This option sets the speed of the traffic recorded by the Analyzer. The default setting is 
Auto-detect. This setting tells the Analyzer to discover what speed traffic is running and 
to label packets accordingly. If you are having problems with your recordings, you might 
try setting the traffic speed to one of the fixed values -- Low, Full, and Hi speed. These 
settings are used when you want to manually set the traffic speed. 

In some rare cases, auto-detection circuitry causes Full Speed devices to fail to 
enumerate on plug-in. Changing the Analyzer speed to Full Speed can sometimes solve 
this problem.

Setting the speed to one of the fixed values is sometimes useful for debugging purposes. 
For example, if a device that is producing numerous errors at a particular speed, you may 
wish to set the recording to that speed in order to ensure that the Analyzer does not 
misread the error packets and label them the wrong speed. While it is unlikely that the 
Analyzer will mislabel packets in this way, manually setting the recording speed 
guarantees that the Analyzer always records packets at the correct speed.

Notes on Hi Speed Recordings
Erroneous chirp blocks can be recorded on an idle bus when the Device has its FS 
terminations on while the Host has HS terminations connected. This causes a small 
differential voltage (“tiny-J”) on the USB bus that causes false Chirp detection. 

This condition occurs during speed negotiation: 
• On a HS bus, the condition is momentary just before the device chirps.
• On a CS bus, the condition occurs both before and after the device chirp (until 

the end of Reset). The user is discouraged from using Speed=HIGH to record 
signals on a classic speed bus.

• The Analyzer stops recording anything for 2.5 milliseconds following a FS_K 
state (which is at least 2 microseconds long). This is to avoid presenting 
“garbage” which is a by-product of the high-speed probe settling down.

Generator/Analyzer Clocking Overrides
Generator/Analyzer Clocking Overrides allows changes to be made to the 
Analyzer/generator clocking. Select Slow Clock, then enter a value in the box on the 
right. The value that is entered tells the Analyzer how much to divide the base clock by. 
For example, entering a 4 causes Full Speed traffic to be generated at a 3-megabit rate 
as opposed to the standard 12-megabit rate.

You can use the slow clock selection to slow down the base clock during generation. This 
also changes the Analyzer’s clock base to match.

Step 1 In the Misc. USB 2.0 tab, make sure you are out of Auto-Detect mode. 

Step 2 Select the Slow Clock checkbox. 

Step 3 In the Divide By field, enter a value. 

Step 4 Click OK.

USB On-The-Go
USB On-The-Go option sets the Analyzer to record the USB On-The-Go traffic. This 
protocol lets you run two devices, specify one of them as the host, one of them as the 
device, and to assign each device a name.
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10.3 Recording Options - Misc. USB 3.0
The Misc. USB 3.0 page presents options for setting Recording Ports,  Simple Triggers, 
and Recording/Generating.

For Recording Ports, select USB 3.0 Connectors or MMCX.

You can Filter Out Logical Idles and SKPs.
For Simple Triggers, and Host Tx or Host Rx, select: Logical Idle, SHP, SDP, SLC, EPF, 
END, EDB, COM, SKP, and/or K-Code.

For Recording/Generating, select Analyzer Only, Host Emulation, or 
Device Emulation. 
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10.4 Recording Rules
Use the Recording Rules to set triggers and filters. 

The page has the following areas: 

• Toolbar: Contains buttons that control the Recording Rules page.
• Available Events Area: Area where you can park Event buttons that you intend to 

use in the Main Display area.
• Main Display Area: Area where you configure trigger and filter rules. You configure 

rules by dragging Event buttons from the Available Events area and then assigning 
actions to those buttons. 

• Config Status Indicator: A button that indicates if the rule is valid or invalid. If a 
trigger or filter rule is configured correctly, the button is green and indicates Config is 
Valid. If a rule is not configured correctly, the button is red and indicates Config is 
Invalid.

Toolbar

Main 
Display 
Area

Config
Status
Indicator 

Available 
Events 
Area
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Pop-Up Menus: When you right-click a button or area in the Recording Rules page, a 
context-sensitive pop-up menu appears that lets you do operations that relate to that 
button or area.

Properties Dialogs: When you click the Show/Hide Properties Dialog button for an 
event, action, or state, a dialog allows you to perform the same operations as in the 
pop-up menus.
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Recording Rules Toolbar
The Recording Rules toolbar buttons control the Recording Rules page. 

Figure 10.1 Recording Rules Toolbar

Table 10.1 Recording Rules Buttons 

Note:  If you have a wheel on the mouse, you can zoom by holding down the CTRL 
key and rolling the mouse wheel.

New Event. Creates a new 
event in the Available 
Events area.

Zoom Out. Makes the 
display appear 
smaller.

Delete Event. Deletes the 
selected event.

Show/Hide Channels. 
Shows or hides the 
channel icon on the 
Event button.

Undo. Undoes the change 
made to Recording Rules 
page. The Undo buffer 
has unlimited size.

Show/Hide Properties 
Dialog. Shows or 
hides the properties 
dialog of the selected 
event, action, or state.

Redo. Restores changes 
done to the Recording 
Rules page.

This display appears 
when the current 
Recording Rules 
configuration can be 
executed by the 
hardware.

Zoom In. Enlarges the 
display (see note). There 
are five zoom levels. The 
default level is the middle 
one.

This display appears 
when the current 
Recording Rules 
configuration cannot 
be executed by the 
hardware.
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Recording Rules Page: How It Works
You can think of the Recording Rules page as a workspace for creating recording rules 
(rules that determine how the analyzer records traces). Recording rules are combinations 
of events and actions. 

An event and the action or actions associated with it form a rule state. One or more states 
are encapsulated in a sequence.

Note:  There can be from one to 512 states within a sequence. You can associate 
one or more events with each state, and you assign each event a different 
action or the same action.

A sequence that has only one state is called a single-state sequence. The analyzer 
continuously watches for each event in the sequence and executes the corresponding 
action if the event is detected.

A sequence that has multiple states is a multi-state sequence. The states are arranged 
in a hierarchy, with a top state and successively lower states. Only one state in a 
multi-state sequence is active at a time. The analyzer does not go to a successive state 
unless it is directed to do so by the previous state.

Sequences are described in detail in “Using Sequences” later in this chapter.

Briefly, creating a rule involves the following steps: 

Step 1 Creating Event buttons in the Available Events area.

Step 2 Drag-and-drop of Event buttons to the appropriate areas (cells) in the 
Main Display area.

Step 3 Assigning an action or actions to each Event button.
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Creating Event Buttons
To create a rule, first create one or more Event buttons. As you create Event buttons, they 
appear in the Available Events area. You then can drag-and-drop them into the Main 
Display area.

To create event buttons: 

Step 1 Click the New Event button at the left side of the toolbar to display the 
New Event pop-up menu. 

Step 2 Select an event, such as Errors. The event appears in the 
Available Events area. 
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Dragging a Button to the Main Display Area
After you create an Event button in the Available Events area, you can drag the button to 
the Main Display area and drop it in the appropriate cell (a cell is a grayed-out rectangle 
with a dashed line around it). You can think of each cell as a target for drag-and-drop of 
an Event button.

There are two types of cell that might appear: Sequence cell and State cell. In the 
Main Display area, they are labelled as follows: 

• Sequence cell: Drag an event here to add a new sequence.
• State cell: Drag an event here to add another state.
If there currently are no events in the Main Display area, a single sequence cell appears 
at the top of the area. 

To drag-and-drop the Event button: 

Step 1 Place the mouse cursor on the Event button in the Available Events 
area. Click the left mouse button.

Step 2 Drag the button to the cell. When the button is in the cell, a dashed 
highlight line appears around the cell. Drop the button in the cell (release 
the left mouse button). The Event button appears in the cell. 

The default label for the first cell is “Sequence 0, State 1." As described later in this 
section, you can change that label using the Properties pop-up for that cell. 

Two new cells appear under the first cell. The first of these new cells is a state cell that 
allows you to create another state in rule Sequence 0 (to make Sequence 0 a multi-state 
sequence).

The second of the new cells is to create a separate sequence, which would be labelled 
Sequence 1.
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Assigning an Action
After you have dropped the Event button in a cell in the Main Display area, you can assign 
an action to the event. 

Note:  If you do not assign an action to an Event button, the analyzer ignores the 
event.

To assign an action to an Event button: 

Step 1 Right-click the Event button to display a pop-up menu. 

Step 2 Select Specify Action, and then choose an action from the submenu. 
The menu closes, and the action is assigned. 

Note:  You can also set actions within the Properties dialog for each event. 
Double-click the Event button to open the Properties dialog, then select the 
Actions tab and set your actions.
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Recording Rules Pop-Up Menus
The Recording Rules window has context-sensitive pop-up menus that are associated 
with the following types of object: cells, events, and actions.

Cell Pop-up Menu
If you click a cell in the Main Display area that has an Event button contained in it, the 
Cell pop-up menu appears. The Cell pop-up menu has the following options.

• New Event: Displays the same menu that you get when you click the New Event 
button on the toolbar.

• Properties: Displays the Properties dialog for the selected cell.

Action Pop-up Menu
If you click an Action button in the Main Display area, the Action pop-up menu appears. 
The Action pop-up menu has the following trigger and filter options: 

• Trigger: Sets or clears Trigger action.
• Filter In: Sets or clears Filter In action. If Filter In is set, you cannot use Filter Out (it 

is disabled).
• Filter Out: Sets or clears Filter Out action. If Filter Out is set, you cannot use Filter 

In (it is disabled).

Note:  Examples that show use of filters are provided later in this chapter.

Advance the Sequence: Creates an event sequence consisting of the event you clicked 
on and an event in a successive state of the sequence. A thick arrow appears from the 
selected event and points downward. 

In other words, the Advance the Sequence button is the link between two states in a 
multi-state sequence. The Advance the Sequence arrow tells the analyzer to go to the 
next state if it detects the event at the tail (origin) of the arrow.
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The Action pop-up menu has the following restart and trigger options: 

• Restart the Sequence (not shown): Restarts the sequence. Note that this option is 
context-sensitive and only appears if you have created a multi-state sequence. A 
thick arrow appears from the selected event and point upward towards the first 
event in the sequence.

• Restart All: Restarts all rules in all sequences and in the global state and displays 
an arrow and a Restart All button. This action precludes selecting Advance the 
Sequence and Restart the Sequence.

• External Trigger Pulse HIGH: Sends an output signal with a Pulse High format 
through the output ports on the back of the UPAS. Pulse High is the default format. 
Pulse High causes the analyzer to transmit a 5-volt, 40-nanosecond signal.

• External Trigger Pulse LOW: Sends an output signal with a Pulse Low format 
through the output ports on the back of the UPAS. Pulse Low causes the analyzer to 
transmit a 0-volt, 40-nanosecond signal.

• External Trigger Pulse TOGGLE: Causes the analyzer to transmit a signal that 
toggles at a trigger event between a continuous 5 volt signal and a continuous 0 volt 
signal.

• Properties: Displays the Action Properties dialog for the selected action.

Event Pop-up Menu
If you click an Event button in the Main Display area, the Event pop-up menu appears. 
The Event pop-up menu has the following options: 

• Specify Action(s): Opens the Actions submenu, allowing you to assign an action to 
the event. Options on this submenu are the same as those on the Action pop-up, 
described previously.

• Add Counter: Adds a counter to count a specified number of times the event 
occurs before the analyzer executes the corresponding action.

• Move Event to: Moves the selected event to a different position in the Recording 
Rules window.

• Copy Event to: Copies the selected event to a different position in the Recording 
Rules window.

• Delete This Event: Deletes the selected Event. Alternatively, you can use the 
Delete button on the toolbar or keyboard to delete events.

• Properties: Displays the Event Properties dialog for the selected event.
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Events and Event Properties
Recording rules are associations between events and actions. These associations 
determine how trace recording occurs. The supported events are:

• Packet Identifiers
• Token Patterns
• Frame Patterns
• Device Request
• Data Pattern
• Bus Conditions
• Errors
• External Input Signals
• Transactions
• Data Length
• Splits

Event Properties (of the Error Event)

The dialog lists the Properties and their Values.
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Data Pattern Mask and Match
If you select Data Pattern as the Event, you can set Data Pattern event properties in the 
Event Properties dialog. 

Click the ... button at the right of the first line to display the Data Pattern dialog.

In the Data Pattern dialog, you can set the Bitmask, Mask, and Match for each bit, 

Bitmask and Match always correlate. When you set Bitmask or Match. the other changes 
to maintain their correlation. 

Note: If you set Bitmask/Match before setting Mask, the Mask changes to the default 
mask. You must change to the Mask that you want. 

If you set an appropriate Mask before setting Bitmask/Match, the Mask does not change 
automatically to a default mask if you change Bitmask/Match.
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Actions and Action Properties
The Actions are:

Action Properties (of the Error Event)

You can set Internal Triggering, External Triggering, Sequencing, and Filtering.

Event Description

Trigger Start recording.
Filter In Include in the trace file the event specified (and no others).
Filter Out Exclude from the trace file the event specified.
Advance the Sequence Go to the next state in this sequence 

(sequence in which this action is located).
Restart All Restart all sequences.
External Trigger Pulse HIGH Send HIGH pulse on external trigger output.
External Trigger Pulse LOW Send LOW pulse on external trigger output.
External Trigger Pulse TOGGLE Send HIGH-LOW pulse on external trigger output.
Properties Opens the Event Properties dialog box.
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Using a Single-State Sequence
As described previously, a sequence can be single-state or multi-state. A single-state 
sequence is a simple combination of events and actions. You cannot create looping or 
branching conditions with this type of sequence. 

A multi-state sequence allows you to branch successively to (advance to) lower states in 
the sequence or to loop to the front of the sequence (restart the sequence). 

Using a Multi-State Sequences
Multi-state sequences allow you to create conditions that branch down to successive 
states or loop back to the beginning of the sequence. They are more complex than 
single-state sequences but very powerful.

Using Independent Sequences
You can use up to two independent sequences. By default, they are labeled Sequence 0 
and Sequence 1. 

The two sequences operate in parallel and have no effect on each other with the following 
exception. Either of the two sequences can contain the action Restart All. This action 
restarts both sequences in the Main Display area.
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10.5 Saving Recording Options
To complete your Recording Options settings, use the features at the bottom of the 
Recording Options screen. These features remain the same no matter which of the 
three Recording Options screens you are working in.

• Click Save to save the currently specified Recording Options for use in future 
recording sessions. Any file name can be specified, though use of the .rec is 
recommended; if no extension is specified, .rec is added by default.

• Click Load to load a previously saved *.rec file, thus restoring a previous set 
of Recording Options.

• The Save as Default function is equivalent to the Save function, specifying 
the file name default.rec. Whenever you start up the Analyzer, it 
automatically loads the default.rec file if one exists.

• Click OK to apply any changes and close this dialog box.
• Click Cancel to cancel any immediate changes you have made and exit the 

Recording Options menu.
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10.6 Recording Bus Data
To start recording USB traffic once the appropriate Recording Options have been set 
perform the following steps. Note: If you have inserted any event triggers, be sure to 
select Event Trigger under the General tab in the Recording Options dialog box. 

Step 1 Select Start under Record on the Menu Bar
OR

Click  on the Tool Bar.

Your recording session can continue until it has finished naturally,

or you may need to stop manually by clicking  on the Tool Bar, depending on how you 
set the Recording Options.

To manually stop recording: 

Step 1 Select Stop under Record on the Menu Bar

OR

Click  on the Tool Bar.

Click  again during the uploading to upload only a portion of the recorded memory. 

Note:  The manual Stop Recording feature is primarily of use when recording 
low-speed traffic, which can take a long time to fill the recording buffer.

When the recording session is finished, the bus traffic is saved to the hard drive as a file 
named data.usb or whatever name you assign as the default filename. 

To save a current recording for future reference: 

Step 1 Select Save As under File on the Menu Bar.

OR

Click  on the Tool Bar.

You see the standard Save As screen.

Step 2 Give the recording a unique name and save it to the appropriate directory.
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10.7 Merging Trace Files (2.0 USB Trainer Files only)
It is possible to merge a Classic-Speed trace file with a Hi-Speed trace file using the 
Merge Trace File command under the File menu. This option only works with files that 
were created simultaneously through a single recording session. If the files were 
recorded during separate recording sessions, the system generates an error message 
and prevents the merge from completing.

Note:  The system can merging High Speed and Classic Speeds traffic into a single 
merged file if the Auto-Merge 2 Channel Trace Files option is checked in 
the Recording Options dialog box.

To merge two trace files: 

Step 1 Select File > Merge Trace Files to display a dialog box asking for the first source 
file.

Note:  The Merge Trace Files command can be run with or without a trace file open 
on the screen. The merge process ignores the open file.

Step 2 Select the first trace file to be merged, then click Save.

Note:  It does not matter which of the two trace files is first selected so long as both 
were recorded in the same session.
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Step 3 Select the second trace file to be merged, then click Save.

Confirm your choices.

Step 4 Click Yes.

The two files are merged into the new file data_merged.usb.

Note:  If you attempt to merge two files that were recorded in separate recording 
sessions, the following error message appears: 



Chapter 10: Recording Options USB Protocol Suite User Manual

172 LeCroy Corporation



USB Protocol Suite User Manual Chapter 11: Traffic Generation (2.0)

LeCroy Corporation  173

Chapter 11:  Traffic Generation (2.0)
USB Traffic Generation allows you to generate USB traffic and test designs under 
realistic conditions. Traffic Generation can also transmit known bad packets, providing an 
opportunity for engineers to observe how a device handles specific adverse conditions.

Traffic Generation Files
The system generates USB traffic from traffic generation files (*.utg) which are 
text-based script files that instruct the Generator how to generate USB traffic. These 
script files can be edited with either a simple text editor such as Notepad or with the Script 
Editor utility provided by the application. The Script Editor utility has several aids to 
simplify the process of writing and editing scripts: tool-tips, drop-down menus, and 
colored fields.

The script example below shows the beginning of a traffic generation file created through 
the Export command. This command provides an easy way to create a generation file - 
you open a trace file, then run the Export command. The trace serves as a blueprint for 
the traffic generation file.

The example below shows several commented lines followed by some instructions. 

This generation file causes the system to simulate a hub and to generate 24,320 packets. 
See Section 11.3, “Device Emulation” on page 182 for details about the format of traffic 
generation files.
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Creating Traffic Generation Files
If you choose to write a script with a text editor, a good way to start is to edit the sample 
generation file that is provided: HS_Hub_Sample.utg. This file is located in the same 
directory as the application (for example, 
C:\Program Files\LeCroy\USB Protocol Suite). You can open this generation file with 
Notepad or other editor and then add or remove text as needed. 

Creating a Traffic Generation File with the Export Command
The Export command offers an easy alternative method of creating a generator file. This 
command converts the trace to a *.utg file, removes all device traffic, and leaves only the 
traffic from the host device. You can then use this file to emulate the host and determine 
whether the device under test is generating the correct traffic.

When creating a .utg file through the Export Packets to Text (Generator Text File Format) 
menu selection, it is suggested that you use the default values presented. Adding NAK 
transactions clutters the .utg file, and including the device side packets creates a .utg file 
which does not work with a real device attached.

To use the Export command: 

Step 1 Start the application.

Step 2 Open a trace that has the pattern of traffic you would like to generate.

Step 3 Select File > Export from the menu bar to display the File Export menu: 
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Step 4 Select Packets to Text (Generator Text File Format) from the Export 
drop-down menu. You see the Export to Generator Text window:

Step 5 Enter the numbers of the first and last packets in the series.

Note:  The device packets are removed from the exported generator text. This is 
essential in creating a generator text file that can be used to handshake with 
your device.

Step 6 You can opt to regenerate the frame numbers and remove the NAKed 
transactions.

Once the generator text file is exported, you may need to edit the file and adjust idle time 
to properly anticipate the responses from your device.
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11.1 Editing a Generation File
A .utg file is a text file that can be edited with any text editor such as Notepad. A better 
editing option, however, is Script Editor of the application. Script Editor provides the usual 
editing functions such as select, cut, copy, and paste but also adds tool-tips, colored 
keywords, drop-down parameter values, and expandable/collapsible packet data fields.

To launch the Script Editor, click the Script Editor  button on the toolbar or right-click 
the trace window and choose Edit as Text.
The Script Editor window opens in the lower portion of the trace window. 

The Script Editor divides into three areas: the toolbar, the script window, and the file tabs 
at the bottom of the window. If errors occur, a log opens at the bottom of the window.
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Toolbar
The Script Editor toolbar contains buttons for saving your edits, navigating, searching and 
other functions. 

The buttons have the following functions:

View Options Menu
The View Options button has a menu with three options: 

• Enable Outlining: Adds an expandable/collapsible tree structure to the left 
side of the Script Editor showing the hierarchical relationships of the script 
lines.

• Show Line Numbers: Adds line numbers to the left side of the Script Editor 
window.

• Show Tooltips: Enables tooltips to appear when the mouse pointer is 
suspended over a script item.

Save. Saves your edits and 
immediately updates the setting bars 
and Frames shown in the trace 
window.

Add/Remove bookmark. Allows 
markers to be set or removed to aid 
in navigation.

View Options. Opens a menu with 
three options: Enable Outlining, 
Toggle Outlining, and Line Numbers. 
See View Options Menu below.

Go to next bookmark.

Cut. Go to previous bookmark.

Copy. Clear all bookmarks.

Paste. Find.

Undo. Find and Replace.

Redo. Go to Trace View
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Pop-up Menu
Right-click anywhere in the script window to open a pop-up menu with the following 
options: 

• Cut
• Copy
• Paste
• Position Trace View on Packet xxx
• List Values
• Toggle Outlining

The List Values option displays the types of values that can be entered for a parameter 
in a line. To see the types of values, select the current parameter, then choose Show 
Values from the pop-up menu.

File Tabs
At the bottom of the window is a tab that shows the name of the .utg file. If your .utg file 
has an Include statement in it, the supporting Include files automatically open when the 
.utg file is first opened. Tabs for the opened Include files appear at the bottom of this 
window. 

Error Log
Whenever you create a scripting error, a log opens at the bottom of the application 
window. When the error is corrected, the window automatically closes. 

Tooltips
The Script Editor window includes extensive tooltips for each keyword. To see a tooltip, 
hold the mouse pointer over a keyword. 
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11.2 Loading the Generation File
The USB Traffic Generation files are scripts that instruct the Analyzer how to generate 
USB traffic. A traffic generation file contains text in special format and is named with a 
*.utg extension. These files can be created by any text editor, or using the File > Export 
> Packets to Text (Generator File Format) menu selection when viewing a Trace File. 
There are several examples of Traffic Generation files included with the installation of the 
software.

To load a generation file: 

Step 1 Select File > Open ... from the menu to display the Open dialog box: 

Step 2 Select Generation Files (*.utg) from the drop-down menu marked Files of Type 
to display a list of Traffic Generation files.

Step 3 Select a Traffic Generation file (*.utg).
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Step 4 Click Open.

The file opens.

Step 5 Decide how many times you want the traffic pattern to be generated, then select 
a value from the Repeat drop-down menu.

The Repeat mode allows for a single pass through the generation file, looping 
forever, or looping 1 to 65,534 times, as desired by the user. If a wrap=HERE 
location is found in the .utg file, that location is where the looping portion begins. 
The loop end is at the end of the .utg file or up to the stop=HERE statement in 
the file.

Step 6 Select the Generation mode in which to generate traffic (see below for an 
explanation) by depressing or undepressing the  
 
IntelliFrame button  on the toolbar: 

• Depressed = IntelliFrame
• Undepressed = Bitstream
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Traffic Generation Modes: Bitstream vs. Intelliframe
IntelliFrame and Bitstream are modes that control how the generator interacts with 
other devices when it is generating traffic. 

• Bitstream Mode -In Bitstream Mode, the generator constructs a bitstream of traffic 
based on the UTG file and assumes that packets start at pre-calculated times. For 
example, after an IN packet, the generator waits a calculated fixed time before pre-
senting an ACK. The time between them is determined by the idle= time statement 
in between the IN and ACK packets in the .utg file. In this mode, every bit time of a 
generation stream (including idles and SE0's) is represented by 4 bits of data, so the 
file to be downloaded to the Generator can be very large.

• IntelliFrame Mode - In IntelliFrame mode, the generator can wait for Device 
responses to complete before it continues generating more host packets. For exam-
ple, after issuing an IN, the generator looks for the DATAx packet issued by the 
device to finish, and then issues an ACK. This way, the data length can vary and 
does not need to be pre-calculated. Also, using the idle=TO_EOF statement allows 
the generator to calculate where the end of the frame occurs, so that a subsequent 
frame=AUTO statement creates a Start of Frame at the correct time. Moreover, the 
Generator can be made to retry transactions that are NAKed automatically, and to 
use the PING protocol where appropriate. Retries can be made to occur within the 
same frame or in the next frame. For further information on the flexible behavior that 
can be instituted during the generation, see the syntax descriptions for the genera-
tion files here. An additional advantage of the IntelliFrame mode is that it creates an 
image in the Generator's memory that is MUCH smaller than that of the Bitstream 
mode, so it downloads much faster. 

Note:  Device emulation only works in Intelliframe mode.

Starting Traffic Generation
 
To start traffic generation, click  on the Tool Bar.

Repeating a Generation Session
If you wish to repeat a generation session, press the 
 
Traffic Generation Start/Stop  button again. There is no need to reload the .utg file.

You can make an additional entry in a Generator Text File that allows you to specify a 
portion of the file for repetition: 

• Enter wrap=here in the Generator Text File.
The traffic above the entry is run only once. The traffic below the entry is repeated 
continuously.

Note:  For a usage example, see the sample file Wrap.utg.

Stop Traffic Generation
To instruct the Analyzer to halt traffic generation: 

• Click  on the Tool Bar.
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11.3 Device Emulation
Device Emulation is a licensed option that allows the system to generate device-side 
traffic. Like host traffic generation, device emulation uses text-based generation files 
(.utg) to generate traffic.

Device emulation has three steps: create a generation file, configure generation settings, 
and then generate traffic.

Creating a Generation File
Generation files can be created one of two ways:

• Write a generation script file using either LeCroy's context-sensitive script 
editor or any text editor that you choose.
OR

• Use a pre-recorded trace file that has the type of traffic that you want to 
generate. This file is a blueprint for the traffic generation script file.

If you decide to use a pre-recorded trace file as a generation blueprint, then verify that 
the trace file contains traffic for only one device. If it does not, hide all the other devices 
(Setup > Level Hiding) and save the file as a new file without the hidden traffic (File > 
Save As and check the option Do not save hidden packets/transactions/transfers).

Setting Generation Options
Step 1 Set the Traffic Generation options by configuring the Misc page in the Recording 

Options dialog box:

Setup > Recording Options > Misc

Step 2 In the Misc page, select Device Emulation Mode.

Step 3 Configure Resume settings.

• If you want the simulated device to issue Resumes, then select Device 
Resumes and enter a delay time (in milliseconds). If you do not select 
Device Resumes, then the emulated device waits for a Host to issue a 
Resume.

• If you want the simulated device to take its address from the Traffic 
Generation (.utg) script file, then select Use Address in .utg file. This 
option causes the system to read the .utg file and assign a Device 
Address based on the device traffic that it sees in the file.

Note:  In this release, the Device Emulator does not look at the Set Address in the 
script, so if your host controller is running more than one device, it may 
enumerate your device emulator incorrectly when you begin to generate 
traffic. The solution is to manually assign a device address. To manually 
configure the Device Address, select Emulated Device's Hex Address and 
enter an address or mask (Note: A mask allows the system to respond to 
multiple device addresses.)

Step 4 Click OK to close the Recording Options dialog and apply the changes. The 
generation settings take effect as soon as you execute a script.
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Run the Traffic Generation Script File
Step 1 Connect the system's port B (either Hi Speed or Classic Speed) to the Host.

Step 2 Open the Traffic Generation .utg file. 

Step 3 Begin traffic generation by clicking .

When execution begins, the system reads the entire generation file and then parses the 
generation commands into groups according to their endpoints. Each of the parsed 
groups of commands are then written into dedicated memory segments in the generator. 
Up to eight memory segments can be created for the various endpoints. In the case of 
Endpoint 0 or any Control endpoints, a single memory segment is created.

Each memory segment can be thought of as a queue of the commands and responses 
for a particular endpoint that occur in the generation file.

Commands are stored sequentially within each memory segment as they occur in the 
generation file. For example, if a generation file has a sequence of command X and Y for 
the Endpoint 1, the commands are extracted in this order and placed in the Endpoint 1 
memory segment.

When the host calls for a particular device endpoint response, the first command listed in 
that endpoint memory segment is then executed. With each subsequent call to the same 
endpoint, commands are executed sequentially down the list as they occur in the memory 
segments. For example, if three calls were made to Endpoint 0 IN, then the first three 
commands in that endpoint's memory segment would then execute.

Note:  Each of the endpoint memory segments execute independently: there are no 
behavioral interactions between the individual endpoints.
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11.4 Format of Traffic Generation Files
Whether you create a traffic generation from scratch or use the Export command, there 
are a few rules about the format of the generation file that you should review. These are 
presented in this section.

Traffic is generated from a text file named *.utg. Within the text file: 

• The data format for data fields such as Pids and Raw bits is hex.
• Each packet definition consists of this set of assignments: key=value. 
• White space is permitted around the equal sign. 
• There are no restrictions on dividing packet definition to lines nor is it 

necessary to define each packet in a separate line, although it is 
recommended. 

• The maximum number of characters in a line is 250.
• The characters # and; indicate end-of-line comments (i.e. the rest of the line is 

ignored)
• Comments are not allowed within brackets ( ).
• No keys or values are case-sensitive.

Each packet definition starts with one of these assignments: 

• pid=N (where N is a string representing a valid packet identifier or an eight bit 
value)
OR

• frame=N (where N is an eleven bit value of the frame number or the strings 
auto and keep_alive).

A bus condition definition starts with one of these assignments:

• reset=N (where N is a positive integer or string)
• suspend=N (where N is a positive integer)
• resume=N (where N is a positive integer)
• chirp=here

Subsequent assignments after a packet’s starting assignment define the values of 
particular fields within the packet. If a field is not defined, it is assumed to be 0. Values 
are assumed to be decimal unless they are prefixed with 0x and then are interpreted as 
hexadecimal. Values within a data block assignment are always assumed to be 
hexadecimal and should not be prefixed by 0x. 
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Table 1: Support Keys for Defining Fields within a Packet
Key Code Format Description
File Control Keys
file_type UPAS

CHIEF
This must be included at the beginning of the file to 
determine the speed of packets to be generated.
Value must be file_type=UPAS to allow for High 
speed traffic, IntelliFrame operation, expected_pid 
and device_pid key support. 
Full and Low speed traffic, and Bitstream operation 
are supported on all file_type= values. 
If this statement does not appear in the file, the 
default is file_type=CHIEF, allowing backward 
compatibility with older USB Chief™ .usb files.

file_version integer This must be included after the file_type= key to 
determine the version of this file. Value is currently 3.
Usage: file_version=3

file_mode HOST
DEVICE

Sets generation mode to host or device. 
For generation to work, this must match the selection 
found in the Recording Options > Misc dialog.

file_speed HIGH
HI
FULL
LOW

This must be included after the file_version= key to 
determine the speed of packets to be generated.
Values are HIGH, HI, FULL, or LOW. 
Example: file_speed=FULL. 
Only one file_speed= is allowed per .utg file, but low 
speed traffic on a full speed bus can be created by 
adding the speed=LOW key to a low speed packet in 
a file defined as file_speed=FULL. No other mixing 
of speeds is allowed. 
HI is the same as HIGH and was added to conform to 
the USB terms.

loop_count
wrap_count

0 through 16382
or "infinite"

These two terms are interchangeable. 
Device Emulation Only. 
This key defines the loop count for each memory 
segment. 
Examples: loop_count=INFINITE or wrap_count=9

wrap
loop

HERE This key marks the wrap point in the traffic. 
When generation is in Repeat mode, all the traffic 
before the wrap point is going to be sent once. All the 
traffic after the wrap point is going to be repeated in a 
loop. 
The usage of the keyword is wrap=HERE or 
loop=HERE. 
For Device Emulation, the value would be a memory 
segment number, so that the looping is associated 
with only that one endpoint, such as wrap=4.
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skip HERE Causes a region in the .utg file to be ignored, as if 
commented out. 
Can be used multiple times in the file. 
Must be used in conjunction with skip_end=HERE. 
Example:
skip=HERE frame=auto makes this statement be 
ignored!
skip_end=HERE

skip_end HERE Causes a region in the .utg file to be ignored, as if 
commented out. 
See above in skip=HERE.

stop string If you want to run only some first portion of the 
beginning of a .utg file, insert this statement where 
you want generation to halt. This saves having to edit 
a file into smaller files when testing a portion of traffic. 
The usage of the keyword is stop=HERE.

break HERE Host Generation Only. 
Enables you to generate up to a point in the .utg file, 
then wait for input before continuing in the file. During 
the breakpoint time, the traffic signal icon in the 
toolbar flashes yellow, indicating that a breakpoint 
was hit. 
When you click the traffic light icon, generation 
resumes. 
If you want to stop rather than continue, select Stop 
from the Generation menu or hit the Start/Stop button 
on the front of the generator module.
Start-of-frames are issued automatically during the 
breakpoint duration. When you resume running, traffic 
begins after another start-of-frame is issued. 
The break=HERE statement must be inserted 
between frame=xxx statements.
Syntax example: 
frame=AUTO break=HERE frame=AUTO

Key Code Format Description
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Endpoint Configuration
begin_config HERE Defines the beginning of the region in the file used to 

configure the endpoint types. 
The configuration is necessary to determine the 
default behavior of the NAK retry mechanism during 
IntelliFrame operation.
Between the begin_config=HERE and the 
end_config=HERE statements is a series of 
config_endpoint=xxx statements, which define each 
endpoint's type and default retry behavior.
The config region must precede any actual packet or 
bus condition statements. 
For Device Emulation, the config region is mandatory. 
It provides the mapping of the endpoints into their 
corresponding segments of Analyzer memory, which 
contain the traffic for those endpoints. 
When exporting to a .utg file from a trace file, these 
sections are created automatically.
Syntax example: begin_config=HERE

end_config HERE Terminates the region in the file used for configuring 
the endpoints. 
See begin_config. 
Syntax example: end_config=HERE

config_endpoint CONTROL
INTERRUPT
ISOCHRONOUS
BULK

Begins a statement that defines a particular 
endpoint's type, default retry behavior (Host 
Generation only), and memory segment (Device 
Emulation only).
Usage example: config_endpoint=BULK addr=1
endp=3 direction=OUT retry=TRUE
retry_next_frame=FALSE

endp_mem_seg 1
2
3
4
5
6
7
8

Device Emulation Only. 
Separates each endpoint function into a different 
queue (also referred to as a Memory Segment) of 
commands and responses. 
There are a maximum of eight of these queues, and 
each has a unique address/direction combination. 
For control endpoints, one queue is shared by both 
directions of the endpoint. 
Traffic on the Default Endpoint (Address 0, Endpoint 
0) shares the same queue as the endpoint 0 of the 
selected device address (the address it gets from the 
Host through the SetAddress request). 
These always use endp_mem_seg=1. 
These are all set automatically when exporting a trace 
file to a Device Emulation .utg file.

Key Code Format Description
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direction IN
OUT

Defines the transfer direction of data for the specified 
endpoint. 
For all transfer types but CONTROL, there can be two 
distinct logical connections using the same address 
and endpoint. They would differ only in defined 
direction. 
Syntax example: direction=IN

retry TRUE
FALSE

Host Generation Only. 
Defines whether an automatic retry should be 
performed on packets to/from this endpoint in the 
case that they are NAKed (or in some cases 
NYETed), or if a timeout on device response occurs.
RETRY only works for the Pids: Setup, In, and Out.
If TRUE, the Exerciser automatically retries the 
specified sequence if a Pid is received on the bus 
which does not match the expected_pid, or if a 
timeout occurs. 
The generator re-issues the host packet(s) after 
waiting either 1/10th of a frame, or until after the next 
start-of-frame (depending on the value set for 
retry_next_frame).
The retries continue until the expected_pid is 
received. 
When a retry attempt finds its expected_pid, the 
Exerciser automatically generates a new 
start-of-frame before continuing with the rest of the 
Gen File. (The start-of-frame is either an SOF packet 
or a keep-alive signal.) 
If FALSE, the Exerciser waits for a Pid before 
proceeding. There is no timeout. 
If a Pid is received which does not match the 
expected_pid, the Exerciser continues to wait for the 
correct Pid to appear. 
If the user stops the generation, a message states 
that the generator was waiting patiently for the 
expected_pid, and it never showed up. The user 
must examine the problem by viewing the trace file.
This statement can also be used in conjunction with 
any pid=xxx statement in the .utg file. This can be 
done to override the configured or default retry 
behavior.
Syntax example: retry=TRUE

Key Code Format Description
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retry_next_frame TRUE
FALSE

Host Generation Only. 
Determines when a retry will be attempted after a 
failed match of an expected_pid. 
This statement only applies if a retry=TRUE 
statement also exists.
If TRUE, the Exerciser waits until the current frame 
completes, issues a start of frame, and then retries 
the transaction. 
If FALSE, the Exerciser waits 1/10th of a frame before 
retrying the transaction. 
Before each retry attempt, the Exerciser checks to 
see where in the frame interval it is. If it is too close to 
the EOF, it automatically generates the next 
start-of-frame before performing the retry. If it is not 
too close to the EOF, it performs the retry without 
generating a new frame.
This statement can also be used in conjunction with 
any pid=xxx statement in the .utg file. This can be 
done to override the configured or default retry 
behavior.
Syntax example: retry_next_frame=FALSE

ping_on_retry TRUE
FALSE

Host Generation Only. 
Determines whether an OUT transaction is retried by 
repeating the OUT-DATAx sequence, or whether a 
PING sequence should be initiated.
If TRUE, the Exerciser automatically generates 
PINGs (and retries) before going through a Retry 
Loop. PINGs are repeated until an ACK is received, 
and then the original OUT-DATAx transaction 
Sequence is attempted. During the PING retries, the 
Exerciser automatically generates frames. When the 
original Retry Sequence receives its expected_pid, 
the Exerciser generates a new frame before 
continuing with the Gen File.
If FALSE, the original transaction is always retried.
This statement can also be used in conjunction with 
any pid=xxx statement in the .utg file. This can be 
done to override the configured or default retry 
behavior.
Syntax example: ping_on_retry=TRUE

Key Code Format Description
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ping_after_nyet Host Generation Only. 
If TRUE, the Exerciser automatically generates 
PINGs (and retries) after receiving a NYET instead of 
the expected_pid. This feature is only used if the 
expected_pid is an ACK. PINGs are retried until an 
ACK is received. When the PING is ACKed, the 
Exerciser generates a new frame before continuing 
with the Gen File. 
If FALSE, the Exerciser continues as if an ACK 
occurred. 
This statement can also be used in conjunction with 
any pid=xxx statement in the .utg file. This can be 
done to override the configured or default retry 
behavior.
Syntax example: ping_after_nyet=TRUE

Key Code Format Description
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Packet Starting Keys
pid 8 bits (0-0xFF)

or 
pid string

Host Generation Only. 
Use this as the first key of most packets sent by the 
Host (Exception: Use frame= for SOF packets). 
The key should be assigned to a valid packet 
identifier string per the USB specification: SETUP, IN, 
OUT, DATA0, DATA1, ACK, PRE, PING, SPLIT, 
DATA2, MDATA, EXT, or LPM. 
Optionally, you may assign this key a raw eight bit 
value to force an error condition.
Warning: If you specify PID=0xNN, you must use 
raw_data=( ) to specify the rest of the packet data, 
because the packet structure is unknown.

expected_pid pid string Host Generation Only. 
Use this as the PID key for packets which are 
expected to be sent by the device. 
In IntelliFrame mode, the generator waits until this 
PID has completed before sending the next 
generated packet or bus condition. 
The key should be assigned to a valid packet 
identifier string per the USB specification: DATA0, 
DATA1, ACK, NAK, STALL, NYET, DATA2, MDATA, 
EXT, or LPM. 
The generator engine waits forever until this 
expected_pid appears, so the user may have to 
hand edit the file to achieve the desired results. 
For example, if a NAK comes where the 
expected_pid was a DATA1, the user should edit the 
.utg file to move the pid=IN command to later in the 
file by inserting some frame=AUTO idle=TO_EOF 
pairs before it. This allows time for the device to be 
ready for the IN. 
If RETRY=TRUE for this address/endpoint, the NAKs 
are ignored and the SOF's are generated 
automatically until the expected PID occurs.

device_pid pid string Use this as the first key of most packets sent by a 
device. 
The key should be assigned to a valid packet 
identifier string per the USB specification: DATA0, 
DATA1, ACK, NAK, STALL, NYET, DATA2, MDATA, 
EXT, or LPM. 
Normally, the device_pid= statement is NOT present 
in a Host Generation .utg file, because the device 
responses are intended to come from real devices. By 
default, Host Generation files exported from Trace 
Files do NOT include device_pid= statements. 
Warning: If you specify PID=0xNN, you must use 
raw_data=( ) to specify the rest of the packet data, 
because the packet structure is unknown.

Key Code Format Description
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frame 11 bits 
or 
AUTO
KEEP_ALIVE

Creates a start of frame packet and generates a 
SOF PID as expected. 
The key should be assigned a value of the frame 
number, AUTO, or KEEP_ALIVE. 
AUTO instructs the generator to increment the frame 
number automatically. 
KEEP_ALIVE instructs the Analyzer to generate a 
low-speed EOP in place of a SOF packet for traffic on 
a low-speed branch (file_speed=LOW).
For Device Emulation, this statement is ignored by the 
Device Emulator, but serves to organize the .utg file 
in a more readable manner.

empty_frame integer Host Generation Only. 
This key creates a sequence of start of frame packets 
with idle=TO_EOF values for the idle time. This 
results in N empty frames, where N is the integer 
value specified. 
If the branch speed is LOW, the frames contain only 
the keep-alive standalone EOP's. This key makes for 
an easier to manage .utg file by eliminating the need 
for many lines of frame=AUTO idle=TO_EOF 
statements. 
Usage:
empty_frames=23; insert 23 empty frames here

host_exp_pid PID Device Emulation Only. 
Defines the PID that is expected to be received from 
the Host. 
The Device Emulator waits until this PID has 
completed before sending the next generated packet.
The key should be assigned to a valid packet 
identifier string per the USB specification: SETUP, IN, 
OUT, DATA0, DATA1, ACK, DATA2, or MDATA. 
PRE and PING are for Hubs only and are not 
supported. 
Each memory segment waits forever until it receives 
the expected PID to its address/endpoint, so the user 
may have to hand edit the file to achieve the desired 
results. 
Each endpoint memory segment acts independently.

Key Code Format Description
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Bus Condition Keys
reset positive 

integer 
or 
LS_EOP

Host Generation Only. 
Indicates the number of microseconds that 
single-ended zeros (SE0) are driven onto the bus.
Assign a positive integer to this key. 
This key can also be assigned the string LS_EOP to 
drive two low-speed bit times of SE0 followed by one 
bit time of J.

se0 positive integer 
<2500

Host Generation Only. 
Same SE0 signal as reset, but the range is in 
nanoseconds (accuracy: +/- 33 ns).

suspend positive 
integer

Host Generation Only. 
Indicates the number of microseconds of idle and 
suspend after the previous packet (for example, for 
ten milliseconds of suspend, the key should equal 
13000). 
Assign a positive integer to this key. 
Note that suspend begins after 3 milliseconds of idle.

resume positive 
integer

Host Generation Only. 
Indicates the number of microseconds of K driven 
onto the bus. 
Assign a positive integer to this key. 
For a proper resume sequence, this should be 
followed by the condition  
reset=LS_EOP speed=LOW. 

wait_resume HERE Host Generation Only. 
Place this immediately before a resume=<> 
statement to implement a device resume, also known 
as Remote Wakeup. 
This causes the host to wait for the device to issue the 
Resume (K) condition before the Host proceeds with 
its own Resume signalling. 
This statement MUST be followed by the  
resume=<> statement.

chirp HERE Used to create a chirp sequence for a High Speed 
generation. 
Usage: chirp=HERE 

wait_vbus VALID Device Emulation Only. 
Wait for VBus to go Hi.

termination HERE Device Emulation Only. 
Set terminations now.

Key Code Format Description
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Keys for Packet Fields
speed LOW Used to cause a low speed packet on a full speed 

branch. 
The only legal value is speed=LOW.

addr 7 bits (0-127) Assign a value for the address field.
endp 4 bits (0-15) Assign a value for the endpoint number field.
hub_addr 7 bits (0-127) Host Generation Only. 

Assign a value for the hub_address field of a SPLIT 
packet.

port 7 bits (0-127) Host Generation Only. 
Assign a value for port field of a SPLIT packet.

data (AB CD) Assign data bytes for the data field. 
Use the following syntax:
data=(12 34 56 78 90 AB CD EF DC 13 40 78 11 CA 
70 65)
You can wrap bytes of the data field to the next line.
The bytes are in the order they come across the bus, 
and the bits within the bytes are in MSB to LSB order.
Maximum number of bytes allowed is 1049.

crc 5 bits (0x0-0x1F) 
or 
16 bits 
(0x0-0xFFFF)

Assign a value for the crc field. 
The default value is the correct crc calculated for the 
packet.

s 0 or 1 Host Generation Only. 
Assign a value for the s (High Speed SPLIT 
Start/Speed) field.

sc 0 or 1 Host Generation Only. 
Assign a value for the sc (High Speed SPLIT 
Start/Complete) field.

e 0 or 1 Host Generation Only. 
Assign a value for the e (High Speed SPLIT End) 
field.

et 0 to 3 Host Generation Only. 
Assign a value for the et (High Speed SPLIT Endpoint 
Type) field:  
0 = Control 
1 = Isoch 
2 = bulk 
3 = Interrupt

eop positive integer Assign a positive integer for the length of the end of 
packet (EOP). 
The default value is the correct length 
(2 bits of SE0, 1 bit of J). 
The value is reflected by <val-1> bits of SE0 plus one 
bit of J.

Key Code Format Description
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hi_eop (AB CD) Hex Used to generate a high speed EOP pattern. 
The bytes are in the order they come across the bus, 
and the bits within the bytes are in LSB to MSB order.
Maximum number of bytes allowed is 13.

idle positive integer
or
TO_EOP

Defines the length of idle after the current packet.
Assign a positive integer or string to this key. The 
positive integer indicates the number of full-speed or 
low-speed bit times. The default value is around 4 bits 
for Classic speeds and around 150 bits for High 
speeds.
When this keyword is assigned a string TO_EOF, 
USB Chief automatically calculates the amount of idle 
remaining in the frame. 
When handshaking with a device, you can use this 
keyword to add idle where you anticipate a packet 
being returned from the device. 
The idle= key is always associated with the 
proceeding packet or bus condition, so you should not 
put file control keys between the packet or bus 
condition statement and the idle= statement.

marker string Assign a string in quotation marks to be put in the 
marker for the defined packet.

raw_data (aa bb) Use to send a non-modulo 8 number of bits in a 
classic speed raw_data packet. 
It is only valid in conjunction with the raw_data 
statement. 
Normally, every bit of the array defined in a 
raw_data=(xx yy) type of statement would be sent. 
However, particularly in the case where bit_stuff=off, 
you need more control over the number of bits to be 
output on the bus. By adding the statement 
raw_data_bits = 11, only the first 11 bits of the 
defined bytes are sent. 
For the following case, 
raw_data=(8F F0) raw_data_bits=13 
the output bitstream would be: 
1111 0001 0000 1 
(Each byte is described in MSB to LSB format, but is 
output on the wire in LSB to MSB format.)

Key Code Format Description
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raw_data_bits integer Use to send a non-modulo 8 number of bits in a 
classic speed raw_data packet. 
It is only valid in conjunction with the raw_data 
statement. 
Normally, every bit of the array defined in a 
raw_data=(xx yy) type of statement would be sent. 
However, particularly in the case where bit_stuff=off, 
you need more control over the number of bits to be 
output on the bus. By adding the statement 
raw_data_bits = 11, only the first 11 bits of the 
defined bytes are sent. 
For the following case, 
raw_data=(8F F0) raw_data_bits=13 
the output bitstream would be: 
1111 0001 0000 1
(Each byte is described in MSB to LSB format, but is 
output on the wire in LSB to MSB format.)

bit_stuff OFF
ON

Assign the string OFF to disable bit stuffing within the 
current packet. 
The default value is ON.

sync integer
1-40

Assign an integer from 1 to 40 to represent the sync 
field. The integer is the number of zeros transmitted 
before the one. 
For Low and Full Speed files, the default value is 7 to 
give a sync of 00000001. 
For High Speed files, the default value is 31 resulting 
in a sync of 00000000000000000000000000000001.

retry
ping_on_retry
ping_on_nak
retry_next_frame

TRUE
FALSE

Host Generation Only. 
These four keys may be applied to individual packets 
to override the behavior in a given instance. 
Normally, they are used in the config_endpoint 
statement. 
See their descriptions in the Endpoint Configuration 
section earlier.

Keys for Class Decoding 
These keys are populated into the .utg. script file automatically whenever the menu command  
File > Export to .utg file is run. These keys do not need to be edited. 
sd_prod
sd_vend
sd_bm_req_type
sd_interface
sd_host_id
sd_class_code
sd_subclass
sd_protocol
sd_end_sd

Key Code Format Description
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Chapter 12:  Updates
From time to time as modifications are made to the Analyzer, it is necessary to update for 
optimal performance. Updates can be performed two ways: either automatically or 
manually. This chapter describes both procedures.

12.1 Software, Firmware, and BusEngine Revisions
The Readme.txt file on the first installation disk and in the installed directory gives 
last-minute updates about the current release. Included with each release are the most 
recent downloadable images of the Firmware and the BusEngine™. 

Once the Analyzer has completed the self diagnostics and is connected to the PC, you 
can check the latest revision of the software and BusEngine by selecting About from the 
Help menu. 

About details revisions of the following software and hardware:

• Software Version
• Unit Serial Number
• Firmware Version
• BusEngine Version
• Serdes BusEngine Version

Note:  When contacting LeCroy for technical support, please have available the 
revisions reported in the About window.



Chapter 12: Updates USB Protocol Suite User Manual

198 LeCroy Corporation

12.2 Software Updates
You can check for software updates manually, or the application can automatically check 
for updates at startup.

Note:  To check for software updates and to download available updates, you need 
an open internet connection.

Manual Check for Software Updates
In the application, you can check for software updates:

Step 1 Select Help > Check for Updates... to display the Software Update window.

If no update is available, the window is: 

If an update is available, the window is: 

To install an available update, click Go to Download Page Now to go to the 
LeCroy web site. Follow the on-screen instructions to download and install the 
software update.

To install available updates later, click Later to close the window and return to the 
application. Note: If you select Later, when you are later ready to install, again 
select Help > Check for Updates…, then download and install the software 
update.
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Automatic Check for Software Updates
You can set the application to automatically check for software updates, either during 
software installation or in the installed application. 

After enabling automatic software update checking, when you start the application, the 
application checks for any software updates. If an update is available, the application 
notifies you. Note: To automatically check for software updates, you need an open 
internet connection.

Note:  Automatic checking for software updates does not download, install, or 
update the application. It only notifies you that an update is available. After 
receiving notification, you must use the Software Update window to 
download and install the latest version of the application.

During Software Installation
During software installation, a window asks if you would like to receive automatic 
notification when software updates are available. Select the checkbox to enable 
automatic checking for software updates. 

When you enable automatic notification of software updates, you accept the 
LeCroy Privacy Policy Agreement. Click the Open Privacy Policy button to view the 
agreement.
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In the Application
In the application, you can set the software to automatically check for software updates:

Step 1 Select Help > Check for Updates... to display the Software Update window.

If no update is available, the window is: 

If an update is available, the window is: 

Step 2 To enable automatic checking for software updates, select the 
Check for updates at application start up checkbox.

The next time you open the application, if you have an open internet connection, 
the application will notify you if an update is available.
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12.3 BusEngine and Firmware Updates
BusEngine, Serdes BusEngine, and Firmware updates often need to be performed when 
you update the USB Protocol Suite software. These updates can be performed 
automatically or manually. Both processes are described.

Updating the BusEngines
The BusEngine core is the heart of the Analyzer. Using state-of-the-art 
Electronically Programmable Logic Device (EPLD) technology, it incorporates both the 
high speed recording engine and the configurable building blocks that implement 
data/state/error detections, triggering, capture filtering, external signal monitoring, and 
event counting and sequencing. The BusEngine program and the Serdes BusEngine 
program, and the Firmware that manages the internal microcontroller, are fully field 
upgradeable.

Within a new software release, it may be necessary to update the Analyzer’s BusEngine 
and Serdes BusEngine hardware for proper operation. The Readme file lets you know if 
this is necessary. 

Updating the Firmware
Within a new software release, it may also be necessary to update the Analyzer’s 
firmware for proper operation. The Readme file informs you if this is necessary. 

Automatic Updates
When the USB Protocol Suite software is upgraded, the software may become 
incompatible with the BusEngine, Serdes BusEngine, and/or Firmware. The next time 
you connect to the analyzer, the application will prompt you if any of the components 
needs to be updated. Follow the on-screen instructions to complete the update.
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Manual Updates to Firmware, BusEngine, and 
Serdes BusEngine
You can manually update the Firmware, BusEngine™, and/or Serdes BusEngine by 
performing the following steps: 

Step 1 Select Setup > Update Device on the Menu Bar to display the Update Device 
dialog: 

The dialog shows the Device Name, Type, Current Version, Required Version, 
Status, and File Name.

Step 2 To update the Firmware, BusEngine, and/or Serdes BusEngine, first select its 
check box.

Step 3 Click Update Selected or click Update All to update all three.

Note:  The most current files were copied to your \LeCroy\USB Protocol Suite 
directory when you installed the program. 

Step 4 Power cycle the Analyzer. Re-initialization takes a couple of minutes.
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12.4 License Information
You can view license information by selecting Display License Information from the 
Help menu. The License Information window indicates the maintenance expiration data. 
It also provides a list of the named features supported by the current software version. 

Named features enabled on your PC are indicated by Yes in the Purchased column. 
Named features that are not enabled on your PC are indicated by No in the Purchased 
column. Whether or not named features are enabled depends on the license key stored 
in your analyzer. 
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If you try to use a feature for which you do not yet have a license, the program displays 
the License Protection Message. Named features that are not enabled on your PC are 
indicated by No in the Purchased column. To use the feature, you must purchase a 
license. 

12.5 Updating the Software License
A current license agreement with LeCroy entitles the Analyzer owner to continued 
technical support and access to software updates as they are published on the LeCroy 
website. 

If your license expires, you must obtain a license key from LeCroy (refer to the contact 
information at the back of this manual.) 

After you obtain a license key, follow these steps to install it:

Step 1 From the Help menu, select Update License to display the 
Select License Key File dialog box. 

Step 2 Enter the path and filename for the license key.

OR 

Browse to the directory that contains the license key and select the *.lic file. 

Step 3 Click Open.

12.6 Registering Online
To register the product online, select Help > Register Product Online.
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Appendix A:  China Restriction of 
Hazardous Substances Table

The following tables are supplied in compliance with China's Restriction of Hazardous 
Substances (China RoHS) requirements: 
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative (“you” or “your”), 
fully complete and return the registration card provided with the 
applicable hardware product or peripheral hardware products 
(each a “Product”) within fifteen days of the date of receipt from 
LeCroy or one of its authorized representatives, LeCroy warrants 
that the Product will be free from defects in materials and workmanship for a period of 13 months 
(the “Warranty Period”). You may also complete your registration form via the internet by visiting 
http://www.catc.com/support/register/. The Warranty Period commences on the earlier of the date 
of delivery by LeCroy of a Product to a common carrier for shipment to you or to LeCroy's 
authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover

This warranty does not cover damage due to external causes including accident, damage during 
shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems with electrical 
power, including power surges and outages, servicing not authorized by LeCroy, usage or 
operation not in accordance with Product instructions, failure to perform required preventive 
maintenance, software related problems (whether or not provided by LeCroy), problems caused by 
use of accessories, parts or components not supplied by LeCroy, Products that have been modified 
or altered by someone other than LeCroy, Products with missing or altered service tags or serial 
numbers, and Products for which LeCroy has not received payment in full.

Coverage During Warranty Period

During the Warranty Period, LeCroy or its authorized representatives will repair or replace 
Products, at LeCroy's sole discretion, covered under this limited warranty that are returned directly 
to LeCroy's facility or through LeCroy's authorized representatives.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-7112

Worldwide: 1 (408) 653-1260
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy Customer Support 

3385 Scott Blvd. 
Santa Clara, CA 95054

Send e-mail… psgsupport@lecroy.com
Visit LeCroy’s web site… http://www.lecroy.com/
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How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or register via the 
internet within the fifteen day period described above and report your covered warranty claim by 
contacting LeCroy Technical Support or its authorized representative. 

You can reach LeCroy Technical Support at 800-909-7112 or via email at support@catc.com. You 
may also refer to the LeCroy website at http://www.lecroy.com for more information on how to 
contact an authorized representative in your region. If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You must ship the 
Product back to LeCroy or its authorized representative, in its original or equivalent packaging, 
prepay shipping charges, and insure the shipment or accept the risk of loss or damage during 
shipment. LeCroy must receive the Product prior to expiration of the Warranty Period for the 
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the repaired or 
replacement Product to you freight prepaid by LeCroy if you are located in the continental United 
States. Shipments made outside the continental United States will be sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy does not 
accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or reconditioned 
parts, at its sole discretion, made by various manufacturers in performing warranty repairs. If 
LeCroy repairs or replaces a Product, the Warranty Period for the Product is not extended.

If LeCroy evaluates and determines there is “no trouble found” in any Product returned or that the 
returned Product is not eligible for warranty coverage, LeCroy will inform you of its determination. 
If you thereafter request LeCroy to repair the Product, such labor and service shall be performed 
under the terms and conditions of LeCroy's then current repair policy. If you chose not to have the 
Product repaired by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
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General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY FOR 
DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT 
AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS EXPRESSLY STATED 
IN THIS WARRANTY STATEMENT, LECROY DISCLAIMS ALL EXPRESS AND IMPLIED 
WARRANTIES FOR ANY PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF 
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME JURISDICTIONS MAY 
NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE 
PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN THIS 
LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES 
INCLUDING, WITHOUT LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST 
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR 
SOFTWARE. LECROY'S LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR 
THE PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE 
PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the then current 
owner transfers ownership of the Product and notifies LeCroy of the transfer. You may notify LeCroy 
of the transfer by writing to Technical Support at LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054 
USA or by email at: support@catc.com. Please include the transferring owner's name and address, 
the name and address of the new owner, the date of transfer, and the Product serial number.



 Limited Hardware Warranty USB Protocol Suite User Manual

210 LeCroy Corporation



USB Protocol Suite User Manual Index

LeCroy Corporation 211

Index

Symbols
.csv file 30
.dec files 97
.lic file 204
.usb files 40
.utg file 30
.utg files 173
.vcd file 30

Numerics
2-stage SOF hiding 94

A
About

command 197
window 197

About window 17
Abstract Control Model .dec file 97
Accurate Time Management 8
Action

button 162
pop-up menu 162
Properties dialog 163

actions
assigning 161
events 161, 164

Actions submenu 163
Add Analyzer Network Node dialog 22
Add Counter option 163
Add Ethernet Attached Device dialog 18
Addr & Endp search criteria 76
Addr field 101
address/endpoint combination 54
Advance the Sequence button 162
alert

beep 149
All Connected Devices command 18
Analyzer

setup 15, 16

Analyzer Devices dialog 18
Analyzer LEDs 12
Analyzer Network Chat Bar 33
Analyzer Network command 22
Analyzer Network dialog 22
Analyzer Ports 12
Analyzer Speed options 153
application

startup 29
Application startup 17
assigning actions 161
ATM Networking Control Model .dec file 97
Audio Class .dec file 97
Audio Class decoding 2.0 97
automatic

updates 201
Available Events Area 155

B
Bar option 125
Beep When Trigger Occurs option 149
bits 50
Bitstream mode 181
Bitstream vs. Intelliframe 181
blue current-position indicator 145
branching 167
BT .dec file 100
Buffer Size box 149
Bulk/Int Transfer field 104
bus

condition 184
condition keys 193
usage 89

Bus Conditions 77
Bus Conditions shortcuts 44
bus data

recording 169
Bus Reset 94
Bus Usage option 133
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Bus Utilization
buttons 124
report 122

Bus Utilization option 89
BusEngine 10

manual updating 202
technology 10
update 201

buttons
bus utilization 124
navigator 68
real-time statistics 131
Script Editor 177
tool bar descriptions 35

Bytes box 149

C
Cable Based Association Framework .dec file 100
CAPI Control Model .dec file 97
CATC Trace

recording 27
set marker 46

Cell pop-up menu 162
cells 160

highlight 160
types 160

Channel
search 78

Channel 0 or Channel 1 packets 94
Check for Updates command 198, 200
Check Syntax command 30
Chirp Bus conditions 94
Chirped packets 54
chirps

hiding 54
class decoding keys 196
class definition files 97
Class Request

decode 114
Class request, decode 114
Class/Vendor decoding 101
Class/Vendor Decoding field 101
Class/Vendor Decoding Groups menu 102
Class/Vendor Endpoint Decoding

field 104
menu 105

Class/Vendor endpoint RPipes decoding 109, 111
Clear Marker command 47
Clear Quick Timing Marker command 48

clock 12, 153
selection 153

Collapse Idle 137
Collapse Idle Plus. 137
Collapse This USB Transfer command 63
Collapsible Idle Time 136
colors

Display Options 91
comments

editing 70
Communication Device Subclass/EEM .dec file 97
Communications and CDC Control .dec file 97
Communications Device Class (CDC) Data 99
Communications Device Class (CDC) Data .dec file 
99
Compare Endpoint Data command 30
compatibility

host 14
components

physical 5
Config Status Indicator 155
Configuration Name option 89
connecting

cables 15, 16, 25
Connection Properties dialog 18
connectivity 14
Continuous Time Scale 137
Control Transfer 112
Control Transfer field 112
convert.usb file 29
Copy Event to option 163
copying events 163
counter 8
counters 163
counting 9, 10
creating

generation file 182
current-position indicator 145
Customize

command 38
dialog box 38

D
Data Block

viewing 53
Data Block dialog box 53
data fields

collapse 51
expand 51
pop-up menus 52
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data length
search for 76

Data option 30, 89
Data Packet Count option 133
Data Pattern Mask and Match 84, 165
Data Payload Throughput option 133
Data View 89
Data View command 140
Data View window 140
data.usb file 40
Decode

decoding options 101
decode

class request 114
endpoint 104, 115
endpoint DWA RPipes 111
endpoint RPipes 109
general options for requests 112
hub status 115
layout 116
protocol-specific fields 63
request recipient 101
Request RPipe 108, 110
requests 112, 113
standard request 113
vendor requests 114

Decode ... Request command 114
Decode as ... Endp command 115
Decode Standard Request command 113
decoded transactions, viewing 59
decoded transfers 62
decoder files 97
decoding

assigning 101
refresh 112

defining packet fields 185
Delay Time 182
Delete button 163
Delete This Event option 163
deleting events 163
delimiters 145
Delta Time 49
device

emulation 181, 182
Device Emulation mode 182
Device IP Settings dialog 20
Device Management Model 97
Device Requests 112
Device Resumes option 182
Device Wire Adapter .dec file 100
Device Wire Adapter Segment View 65

Device Wire Adapter Transfer View 65
devices

hiding 54
DHCP 19
DHCP network 16
diagnostics 15
Direct Line Control Model .dec file 97
direction

search 85
Direction field 104
display 14

configuration name 89
format 27
graphs 133
options 7
windows 30

Display License Information 203
Display Options

Color/Format/Hiding tab 90
factory settings 89
General 88
level hiding 94, 95
loading 96
saving 96
values 89
window 87

Divide By field 153
Downstream Packets 55
dragging buttons 160
DWA RPipes

endpoints 111

E
Edit as Text command 30, 176
Edit Comment command 30, 70
Edit comment for trace file window 70
Edit Marker Comment

command 47
window 46

editing
comment 70
generation file 176
marker 47, 48

Electrical Idles 55
Electrically Programmable Logic Device 10
Electronically Programmable Logic Device 201
e-mail 207
emulation 181, 182
Enable Outlining command 177
Enable Tips option 88
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Endp field 104
endpoint

configuration keys 187
decoding 104

Endpoint RPipes
dialog box 109, 111
tab 109, 111

Endpoints
tab 104

endpoints
decoding 115
DWA RPipes 111
RPipes 109

Endpoints dialog box 104
environmental conditions 13
EPLD 10, 201
error

detection 9
error log 178
Error Report option 89
Error Summary report 119
errors 89

searching for 75
summary 119

Errors option 69
Errors pane 144
Ethernet connection 16
Ethernet connector 12
Ethernet Networking Control Model .dec file 97
Event buttons

creating 159
dragging 160

Event pop-up menu 163
Event Properties dialog 163
Event Trigger recording 148
Event type 80
events 9, 164

actions 161, 164
buttons 159
copying 163
deleting 163
moving 163

Events Group box 83
Exclusion search 83
Exerciser LEDs 12
Exerciser Ports 12
Expand Packet Data Fields by default option 88
Expand Script-Based Decoded Info by default op-
tion 88
Expand This USB Transfer command 63
Expand Transaction menu 60

expiration
maintenance 203

Export command 30, 173
Export to Generator Text window 175
external clock 12
External Trigger Pulse

HIGH option 163
LOW option 163
TOGGLE option 163

F
fax 207
features 5

named 203
trace 27, 45

fields
expanding 51

Fields option 89
file

generation format 184
File Control Keys 185
File Export menu 174
File Information report 118
File menu 30
files

.dec 97

.utg 173
editing comment for trace 70
File Control Keys 185
file information 118
generation loading 179
information 118
loading generation 179
script 97
tabs 178
trace filename 151

Files of Type field 179
Filter In

action 162
option 162

Filter Out
action 162
option 162

Filter Out Logical Idles and SKPs 154
filtering 9

hardware 4
filters 155
Find

command 82
utility 82
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Find Next command 85
firewall 16
firmware

automatic updates 201
update 201

first recording 25
Fit to Graph Area option 132
fonts

changing 89
Fonts and Colors options 126
Fonts option 89
format

display 27
display options 92

fractional clock rate 7

G
General tab

Display Options 88
Recording Options 148

Generate menu 31
generating

traffic 7
generation

file loading 179
formats 184
mode 180, 181
options 182
repeating 181
running 183
session 181
starting 181

generation file
creating 182
editing 176
loading 179
repeat 181

Generation Files option 179
generation script file 182
Generator Text File 181
Generator/Analyzer Clocking Overrides option 153
Gigabit Ethernet connector 12
Go to

Marker search 72
Packet/Transaction/Transfer... search 72
Trigger search 71
USB2.0 73
USB3.0 79

Go to Marker command 136

Go to USB2.0
drop-down menu 73, 79

Graph Areas button 133
Graph Areas menu 127
graphical display 8
graphs

displaying multiple 133
Graph Areas menu 127

Grid Lines option 125
Grid on Top option 125

H
hard disk 14
hardware

filtering 4
requirements 14

Help menu 34
Hi Speed

recordings 153
HID .dec file 98
Hide buttons 136
Hide Downstream Packets 55
Hide Electrical Idles 55
Hide Inter-Packet Symbols 55
Hide ISO Time Stamp Packets 54
Hide LFPS Packets 55
Hide Link Commands (Flow Control) 54
Hide Link Commands (other than Flow Control) 55
Hide Link Training Sequences 55
Hide LMP Packets 55
Hide Logical Idle Packets 55
Hide option 132
Hide Skip Sequences 55
Hide Upstream Packets 55
hiding

chirps 54
devices 54
display options 93
Idles 136
levels 94, 95
NAKs 54
SOF packets 54
toolbars 35

Hierarchy Lines option 88
High, Full, or Low Speed packets 94
Hi-Speed traffic 7
HNP 78
host

compatibility 14
Host field 101
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Host Negotiation Protocol 78
Host option 78
Host PC Configuration 1
Host Wire Adapter .dec file 100
Host Wire Adapter Segment View 64
Host Wire Adapter Transfer View 65
hosts

Host Negotiation Protocol 78
with a B plug 78
with an A plug 78

hot keys 43
HS_Hub_Sample.utg file 174
Hub .dec file 98
HUT .dec file 98
HWA address field 108

I
Import command 30
Include statement 178
independent sequences 167
information

priority 146
initialization 15
installation 15
Installation CD 15
IntelliFrame

button 180
mode 181

Interface Association Descriptor .dec file 100
Inter-Packet Symbols 55
Intersection search 83
IP Address 18
IP settings 19
IP Setup 19
ISO Time Stamp Packets 54

K
Keep Across Recordings checkbox 103
keyboard

shortcuts 43
keys

bus condition 193
class decoding 196
endpoint configuration 187
file control 185
packet fields 194
packet starting 191
support 185

Keys for packet fields 196

L
layout 116
Layout command 116
Legend 69
Legend option 145
letter 207
LFPS Packets 55
license

agreement 204
information 203
key 204
updating software 204

License Information window 203
License Protection Message 204
line numbers 177
Link Command 80
Link Commands (Flow Control) 54
Link Commands (other than Flow Control) 55
Link Tracker

buttons 137
toolbar 134

Link Tracker window 134
docking 136
markers 136
reformat 134

Link Training Sequences 55
Link utilization 133
Link Width pane 144
linking states 162
List Values option 178
LMP Packets 55
LMP Subtype 80
Load command 96, 150, 168
log

error 178
Logical Idle Packets 55
logical objects 66
looping 167

M
Main Display Area 134, 155
maintenance expiration 203
Manual Trigger recording 148
Map DWA RPipe to Class/Vendor Decoding com-
mand 110
Map Endpoint to Class/Vendor Decoding command 
104
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markers
clearing 47, 48
defining 46
editing 47
setting 46, 136

Mass Storage .dec file 98
Media Transfer Protocol 66
memory 13, 14

requirements 149
menus 30

graph areas 127
pull-down 30
real-time statistics 132
view settings 125

Merge Trace Files command 30, 170
merging

trace files 170
Misc USB 2.0 tab

recording options 152
Misc USB 3.0 tab

recording options 154
MMCx plug connectors for interfacing 12
Mobile Direct Line Model 97
mode

Bitstream 181
collapsed 88
device emulation 182
expanded 88
generation 180
Repeat 180
traffic generation 181

Monitor .dec file 98
monitoring statistics 129
Move Event to option 163
moving events 163
MTP 66
Multi-Channel Control Model .dec file 97
multi-state sequences 158

N
NAK’ed transactions 94
NAKs 54

hiding 54
name of Recording Options settings 150
navigating 141
navigation 89

shortcuts 43
tools 42

Navigation Bar checkbox 68

Navigator 141
displaying 141
legend 145
panes 142, 144
range 142, 143
ranges 142
slider 145
toolbar 142

navigator 68
Navigator bar 68
Navigator Legend dialog box 145
Navigator option 89
Navigator Panes button 145
Navigator Range button 143
network 16
New Event

button 159
option 162
pop-up menu 159

No Decoding option 103
None option 125

O
OBEX Model 97
object handles 66
object transfers 66
On the Go, searching 78
Operating Systems 1
opt files 96
options

display 7
recording 6
search 71

options file 89
Options Name field 150
Orient Horizontally option 125
Orient Vertically option 125
OTG shortcuts 44
output signals 163
overview

software 29

P
Packet # field 46
packet fields keys 194
Packet label 50
Packet menu 46
packet starting keys 191
packet type 79
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packet types
USB 3.0 45

Packet View 57
packets

defining fields 185
definition 184
display level 89
hiding SOF 54
packet starting keys 191
searching for IDs 74
view 27

Packets to .CSV option 30
Packets to Device Emulation Traffic Generation 
Text File option 30
Packets to Host Traffic Generator Text File option 
30
Packets to Text (Generator Text File Format com-
mand 175
Packets to Text option 30
packing list 11
pane checkbox 145
Partial Upload 40
Partial Upload button 40
PC Configuration 1
percentages, post triggering 150
Photographic and Imaging Manufacturers Associa-
tion 99
PHY type 79
Physical .dec file 98
physical components 5
Physical Interface .dec file 98
physical memory 149
Picture Transfer Protocol 66
Picture Transfer Protocol .dec file 99
PID shortcuts 43
PIMA 99
Point of Sale Devices .dec file 98
pop-up menu

Script Editor 178
pop-up menus

data field 52
Recording Rules 156

pop-up tool tips 54
position of trigger 150
post-triggering percentages 150
Power .dec file 98
power connector 11
power requirements 13
Power Switch 11
Pre/Post Trigger option 69
Pre/Post Trigger pane 144

Printer .dec file 98
probing 13
program

startup 29
Progress Indicator 39
Properties

option 162
Properties dialog box 132
Properties options

actions 163
events 163

protocol
violations 9

protocol for mixed file 85
Protocols of Traffic 144
protocol-specific fields, decode 63
PTP 66
PTP .dec file 99
PTP Object 66
PTP Session 67
PTP Transaction 66
pull-down menus 30
Pulse High format 163
Pulse Low format 163
Purchased column 203

R
range delimiters 145
raw bits 50

viewing 50
Raw Bits View 50
Readme.txt file 197
Real-Time Statistics

buttons 131
Real-time Statistics

pop-up menu 132
window 129

Real-Time Statistics option 89
Recent Ranges option 69
Recently Used Ranges 143
Recipient field 101
Recommended Host PC Configuration 1
Reconnect command 22
Record menu 31
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